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1 Safety

1.1 General

Approved usage ControlCare P View is a SCADA program that allows the visualisation and monitoring of production 

processes. It is normally sold as a package that has been tailored to customer requirements. In this 

case, operating instructions for the application will be included as part of the project documentation. 

The Getting Started document gives an overview of program functions. 

Installation, 

commissioning, operation

The project is delivered on a CD ROM. Normally, the project will be installed as part of the Site 

Acceptance Test, and the user will not have to do it himself. If this is not the case, it can be installed 

by inserting the CD ROM in the computer’s drive and following the set-up instructions. The doing 

this personnel must be authorised, have administration rights and be suitably qualified.

1.2 Conventions and icons

In order to highlight safety relevant or alternative operating procedures in the manual, the following 

conventions have been used, each indicated by a corresponding icon in the margin. 

Safety conventions Icon Meaning

A note highlights actions or procedures which, if not performed correctly, may indirectly affect operation or 

may lead to an instrument response which is not planned

Caution!

Caution highlights actions or procedures which, if not performed correctly, may lead to personal injury or 

incorrect functioning of the instrument

Warning!

A warning highlights actions or procedures which, if not performed correctly, will lead to personal injury, a 

safety hazard or destruction of the instrument
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2 ControlCare P View Architecture

Welcome to the Endress+Hauser Control P View Web-enabled industrial automation software for 

Microsoft® Windows® operating systems, featuring OPC-based client and server applications for 

Human Machine Interface (HMI), SCADA and Control.

This Quick Start manual will help you get up and running with your new software quickly and 

easily.  It will show you how to:

• Install the P View software

• Authorize a P View software license

• Navigate the P View Demo.

• Use the P View quick start tutorials to create a simple project with graphics, trends, and alarms

• Access online help and technical support

There is also a section on tips and tricks for working efficiently on projects, and a quick explanation 

of the other tools offered by P View. 

2.1 What is OPC?

OPC is a standards-based approach for connecting data sources (e.g., PLCs, controllers, I/O devices, 

databases, etc.) with HMI client applications (graphics, trending, alarming, etc.). Originally the 

acronym stood for OLE for Process Control; but more recently the term has been phased out in favor 

of Data Access Specification or altered to indicate that OPC stands for "openness", "productivity", 

and "communications."

OPC enhances the interface between client and server applications by providing a universally 
supported and well-documented mechanism to communicate data from a data source to any client 
application. Included are not only a detailed guide on how to pass the data, but also specific 
information on other attributes to supplement those data, such as range information, data type, 
quality flags, and date and time information. Figure 2-1 shows the OPC Architecture, which was 
introduced by the OPC Foundation. By following the OPC Architecture, a device needs only one 
standard driver, which is an OPC-compliant server. All OPC-compliant client applications can then 
be connected to that device, either locally or over a network. Furthermore, connections can be 
made to more than one OPC server at the same time
.

Fig. 2-1:  OPC-Based Client-Server Architecture

Any OPC client application can connect to any OPC server. In other words, OPC offers true Plug-

and-Play capability in the fields of HMI and industrial automation. OPC server types include OPC 

Data Access (DA), OPC Alarm and Events (AE), and OPC Historical Data Access (HDA).
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2.2 What is ControlCare P View?

Controlcare P View offers the following stand-alone OPC client applications for graphics, data 

collection and trending, alarming, and scheduling:

• Graph: OPC visualization and HMI product with extensive Symbol Library

• Trend: OPC real-time trending and data historian

• Alarm: OPC alarm summary viewing, logging and reporting

• Scheduler: Schedule the automatic downloading of OPC values 

Each client application is an ActiveX® container featuring Internet/intranet-ready object technology 

and offering Microsoft's powerful Visual Basic® for Applications (VBA) technology.

ControlCare P View is a collection of these software components that provides a complete solution 

for HMI/SCADA software applications.  In addition to the above four main modules, P View 

includes the following applications:

• P View Project: Management, collaboration and deployment of P View projects

• Data Collector: OPC data bridging, OPC aggregation, OPC tunneling, and OPC redundancy

• Script Tool: Centralized periodic and event scripting with multi-threading VBA

• Trace: XML-based audit trail diagnostics and debugging utility

• VCR: Graphical and visualization playback of historical alarms and data

• WebHMI: Web-based real-time automation and visualization software

• Alarm Multimedia: Multimedia OPC alarm management software

• Unified Data Manager: Enables the centralized management of commonly used expressions, 

value sets, tag groups, alarm subscriptions, alarm filters, recipes, and event triggers across P 

View products as well as other Endress+Hauser products  

• OPC Servers: Various OPC servers commonly used with P View

Many other important tools and utilities are also installed with ControlCare P View, including:

• Screen Manager

• OPC DataSpy

• P View Broker

• P View Tray, Monitor

• Security Server

• Unified Data Browser

• Expression Editor

• Global Aliasing Configurator

• Language Aliasing Configurator

• Data Mining Configurator

• SNMP Configurator
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2.3 System Architecture

Figure 2-2 illustrates the P View components fit together within the OPC automation architecture. 

For more information about Endress+Hauser products, please the Endress+Hauser site at 

www.endress.com.

Fig. 2-2:  Control P View Architecture
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2.4 System design

When designing your system, keep in mind that the various applications can run as a stand-alone 

or as a suite on each PC.  For example, the system in Figure 2-3 shows several P View stations. Each 

of these could be dedicated to alarming, trending, graphic screens or a combination of all. P View 

offers the flexibility to scale and expand, as your system needs change.

Fig. 2-3:  System Design Example
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3 Installation and Requirements

3.1 System requirements

3.1.1 Operating system

ControlCare P View supports the following operating systems:

• Windows Vista x32 or x64

• Windows Server 2003 x64

• Windows Server 2003 R2 

• Windows Server 2003 SP2 

• Windows Server 2003 SP1 

• Windows Server 2003 

• Windows XP Professional x64

• Windows XP Professional SP2 

• Windows XP Professional SP1 

• Windows 2000 SP4 

• Windows 2000 Server SP4 

3.1.2 Hardware Requirements

Note! 

• Specific hardware requirements depend on the size and complexity of your ControlCare P View 

implementation. With any application, faster CPU speeds and increased physical memory (RAM) 

result in better performance.

• ControlCare P View supports dual-core and hyper-threaded systems.

• The actual amount of space required may decrease if help and example files are not installed.  

Requirements for logging data, alarms and screen storage are above this minimum.  Virtual 

memory requires at least twice the amount of the physical RAM.

The hardware requirements described below are based on typical applications. Depending on your 

specific application, the minimum requirements may vary. In order to recommend specific system 

requirements, we must break the systems up into three categories based on tag count and running 

applications. In all systems we recommend that the virtual memory allotment be two times the 

amount of physical memory (RAM) on the system.  

For the systems below, we are assuming that the OPC server(s) are installed locally on the system 

and that the following Endress+Hauser components are all running and using the tag count 

specified per classification: Alarm Server, Alarm Logger, Trend Logger, and Graph with Alarm 

Viewer and Trend Viewer.

Hardware requirements Hardware/Software component Less than 500 tags* 500 - 3000 tags More than 3000 tags

Processor CPU 1.0 GHz 2.0 GHz 3.0 GHz

Physical Memory (RAM) 512 MB 1.0 GB 2.0 GB

Hard Disk space available 2.0 GB 4.0 GB 10.0 GB

DVD optical drive 

SVGA Video Card; 256 or more colors for best results

A mouse or other compatible pointing device

Microsoft-compatible keyboard

Microsoft Internet Explorer 6.0 or higher

Ethernet adapter optional, for remote PC connections or Ethernet I/O

3.5-inch floppy drive optional, for license transfer

Parallel printer port optional, for hardware license

USB port optional, for hardware license or license transfer

Serial COM ports or other adapters optional, for data I/O

* Corresponds to minimum requirement



ControlCare P View - Quick Start 3 Installation and Requirements

Endress+Hauser 11

3.2 Installing P View

Note! 

• If your operating system requires a login name, you must log in with administrator capability 

before installing P View software. 

• To run the P View applications, you must be logged into the operating system with an account 

that is a member of the "Administrators" group or the "Power Users" group.

• During the installation, the system will look for a prior installation of the Endress+Hauser License 

Utility. If a previous installation of the License Utility is detected, an update is required. If your 

PC is currently licensed, a temporary P View 2.02.xx license with the current configuration can 

be immediately granted for a 30-day temporary period. All current options and licensing 

information will be retained for 30 days.

The following steps detail the P View system installation. For complete information with installation 

screens, please see the Getting Started documentation supplied with the installation disc or as PDF 

on the product DVD.

Procedure 1. Before installing ControlCare P View software, be sure that all other applications are closed 

and/or disabled.

2. Insert the P View product DVD into your DVD-ROM drive.  If "Autorun" is enabled on your 

system, the DVD introduction starts automatically.  Otherwise, browse to your DVD-ROM 

drive and run the "RunMe.bat" file. 

3. You will see the CD introduction and the main menu.

–  Select Software Installation then P View 

4. If you are using a Vista or Windows Server 2008 system you will be prompted by the User 

Account Control system to give permission. Click Continue to continue.

5. The Setup screen briefly appears, followed by the Welcome Message screen. 

– Click the Next button to continue.

6. The Software License Agreement dialog box appears. 

– Read the License Agreement

– Click Yes if you accept the terms of the agreement.

7. The Choose Destination Location dialog box appears. 

– Select the destination location for the software installation. 

– The default directory for the setup is Endress+Hauser\P View. 

– If you wish to keep this default location, click the Next button to continue. 

– If you prefer to select a different directory location for the installation, 

 click the Browse button to select a different drive or directory. 

 Click Next to continue.

8. The Setup Type dialog box appears. Select the setup type to install.

– If you choose Typical or Compact, please continue with 10.

– If you choose Custom, please continue with 9.

9. The Select Features dialog box appears. 

– Select the features as required.

10.The Please choose the Language(s) dialog box appears

– Please choose the languages to be installed.
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11.The Installation Type dialog box appears. 

Here there are two additional options available for a P View installation:

Browser Station Installation. This option should be used when installing the software on a 

networked PC that ties into another P View system.  A "Browser Station," which cannot 

connect directly to an OPC server, must connect to a remote machine. For a typical 

installation, this option should NOT be checked.

A Browser Station (or GenBrowser) gets its license from a remote node that is licensed for 

GenBrowser workstations. All data I/O needs to be from remote servers, except Data Collector 

data where the origination point of the data is remote, but the Data Collector installation is 

local.

Graph Runtime Only. This option creates an installation whereby P View Graph (the 

graphics screen-building module in P View) cannot enter Configuration mode. For the typical 

installation, this option should NOT be checked. 

12.Click Next to continue.

– The copying of files will now begin.

– Click Cancel to stop the installation procedure at any time. 

13.The AppSetupUtility dialog box appears

– This utility sets the DCOM permissions of P View applications and services to run under 

a user-specific account. 

–1 Please choose an existing user or create a new one.

14.Click the Finish button. 

Note! 

• The P View installation automatically installs Microsoft® Visual Basic® for Applications (VBA). 

• If you are using the Unicode version of P View for international language-switching capability, the 

installation will give you the option of installing Microsoft Arial Unicode Font. 

• The installation also installs a Dot Matrix Font on your computer.
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3.3 Uninstalling P View 

The P View software can be uninstalled (removed) from the system, with all of your project-related 

files left intact.

Note! 

• If your operating system requires a login (e.g., Windows 2000), you need to log in with 

administrator capability to uninstall.

To uninstall P View: 1. From the Windows Start menu, select Settings > Control Panel.

2. Double-click on Add/Remove Programs.

3. From the list of programs that you can remove, select Endress+Hauser P View:

4. Click on Change/Remove to remove P View and all of its components.

5. When the files are removed, the uninstall program will indicate that the process is complete.  

Click OK.

Note!

• Uninstalling ControlCare P View (or its components) will not uninstall the Licensing software. 

Your valid license will remain activated on your PC. 
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4 Endress+Hauser Software Licensing

4.1 Introduction

P View software products use a software-based licensing scheme.  An activated license is required 

to use the software in full production mode.  This license designates which products may be used, 

as well as the I/O point-count limit used in the system. This document explains the concepts of the 

software licensing and shows how to install and activate the license.

Note! 

• The system will run in a two-hour Demo mode without a site key enabled.

• P View version 2.x software licenses must be upgraded to work with P View version 2.02.xx or 

subsequent versions of P View

4.1.1 Upgrading licences

If you wish to upgrade your ControlCare P View Software License for version 2.x, simply install the 

new version over the existing version. It is NOT necessary to uninstall the old version before 

installing the new version. The version 2.02.xx licensing installation allows for a conversion of 

existing version 2.x licenses to a version 2.02.xx temporary 30 day license. During the 30 day 

temporary licensing period you will need to obtain and install a permanent license. Version 2.02.xx 

licenses with a lower build number (xx) do not require an upgrade.

To install Version 2.02.xx on a system with an earlier version than 2.x requires uninstallation of the 

previous version first. After you install Version 2.02.xx you will have a temporary 30-day license. 

Two changes have been to P View 2.02.xx licensing. The licensing server can now run on all 64-

bit Windows operation systems. Additionally, a new hardware licensing key is available from 

Endress+Hauser.

4.1.2 Tag Count Architecture

ControlCare P View offers an open, scalable, modular and flexible HMI/SCADA system with a 

unique tag count architecture. The ControlCare P View tag count architecture provides the 

maximum features and capability at a minimum cost when licensing P View and other 

Endress+Hauser automation products. The tag count architecture was designed to count only active 

OPC "in-use" or "runtime" tags for product licensing. It does not count "configured" or "calculated" 

tags in its licensing calculations. Since the tag database is defined in the specified OPC servers, 

Endress+Hauser aggregates these tags references into various modules of P View. The tag count 

starts only during the runtime operation of the system on a unique tag count basis. The following 

points summarize the tag count architecture:

• Only active OPC tags are counted.

• The same tags used in multiple modules are counted only once. 

• Expression and calculation results are not counted as tags.

• Local variables are not counted as tags.

• A license monitor utility (Monitor) shows the actual tag usage and availability of total tags.
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4.1.3 Free Development

There are two distinct modes of operation within the P View software modules: Configuration and 

Runtime.

• Configuration is the product's capability to let you configure the system--to create graphic 

displays in P View Graph, for example, define which data to log in P View Trend, and configure 

which OPC points to monitor for alarming in P View Alarm, etc.  Many refer to Configuration 

mode as "Development" mode, since the entire project is designed and developed in this mode. 

Configuration mode in P View does not require an installed software license.  You may develop 

your system on any machine.

• In Runtime mode, modules communicate with the actual I/O (Input/Output), talk to network 

nodes, and animate the documents made by using Configuration mode.

Note! 

• A fully functioning runtime system requires a license.

4.1.4 Free Demo Mode Runtime

Without a valid license installed in your PC, it is still possible to enter Runtime mode (described 

above). The software will check for a valid software license key on initialization. If none is found, 

P View runs in Demo mode. It has the following limitations:

• It will only permit Runtime mode for two hours.

• Only 32 OPC tag connections (points) will be updated.

Running past the two-hour limit generates a message stating that the demo time has been exceeded.  

You must then exit.  On restarting, you will get another two-hour block of time in which to run.  If 

there are more than 32 tags on a particular screen, gray stars (or whatever is configured as the Point 

Failure character) will appear in place of the actual I/O data.

If you intend to run in Demo mode, skip to Chapter 5.
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4.2 Installing Endress+Hauser Software Licensing

You must install and run Endress+Hauser Software Licensing before you can run P View software 

in non-demo mode. By installing the Endress+Hauser 2.02.xx License Utility, you will no longer be 

able to run earlier versions of P View. 

If you have an existing Site Key for an earlier version, a temporary 30 day license will be authorized 

for P View 2.02.xx. In order to proceed with the License Utility installation, you must acknowledge 

that you have read the version compatibility notice displayed in the installation screens.

Note! 

• Version 2.02.xx licensing installation allows for a conversion of existing version 2.x licenses to 

version 2.02.xx for a temporary 30 day period. Version 2.02.xx licenses with a lower build 

number (xx) do not require an upgrade. To install Version 2.02.xxon earlier versions, uninstall 

those versions first.

• Set the System Date and Time properly before installing the Software License Utility. Setting the 

time and/or date by more than an hour after the installation will affect any time-limited Licenses 

(such as the Temporary 30-day Activation)

• If your operating system requires a login name, you must log in with administrator capability 

before installing Endress+Hauser Software Licensing

The following steps detail the Endress+Hauser Software Licensing installation. For complete 

information with installation screens, please see the Getting Started documentation supplied with 

the installation disc or as PDF on the product DVD.

Procedure 1. Before installing Endress+Hauser software, be sure that all other applications, such as Microsoft 

Office or any antivirus software, are closed and/or disabled.

2. Insert the P View product DVD into the DVD drive.

3. You will see the DVD introduction and the main menu. If Autorun is enabled on your system, 

the DVD introduction starts automatically. Otherwise, browse to your DVD drive and run the 

"setup.exe" file. 

4. Select Software Installation then P View from the menu.

5. Now select P View Licensing.

– The Software License installation starts and displays a Welcome screen. 

– Click Next to continue.

6. The Software License Agreement appears. 

– If you accept the terms of the agreement, click Yes.
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7. The Please choose the Language(s) dialog box appears.

– Choose the language(s) to be installed.

– Choose the destination directory for the installation. This defaults to 

8. Endress+Hauser\P View Licensing 

– If you want to install the License Utility in a different directory, click Browse. 

–  Click Next to continue.

9. Setup will also create a program folder and copy all the shortcuts related to the License Utility 

into that program folder. The default program folder is Endress+Hauser Software Licensing. 

You can specify a different folder if you want. Click Next to continue. 

Setup will start copying files to your computer and will display the status associated with the 

memory, disk space, and percentage of information copied.

10.Read the important notice which now appears stating that the 30-day temporary license must 

be activated to provide a Site Code in order to obtain a valid Site Key

– In order to complete the License Utility installation, you must acknowledge that you 

have read the notice by pressing

– Check the box and click the Next button to continue.

11.Setup is now ready to install the program

– Press Install to continue

12.When Setup is complete, decide whether to restart your computer now or later by checking 

the appropriate box. 

– Click the Finish button to exit the installation wizard. 

Note! 

• You must now run the License Utility and register your software license in order to use P View 

or any of its components.  For more information, see Chapter 4.3

• If not done at Step 12, restart your computer before running the license facilty
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4.3 Running the License Utility

The P View Software License Utility provides full authorization to any of the purchased P View 

products and its available options. 

4.3.1 Temporary authorization of P View system

1. Launch the License Utility from the Windows Start menu, 

Select Programs > Endress+Hauser > P View > P View License > License Utility. 

(This program may already have been started if you checked the box to launch it after 

installation.)

2. A dialog box opens as shown below, informing you that P View is not authorized. You must 

first activate a temporary software license.  Click OK to continue.

3. If you are running the License Utility for the first time before authorizing your license on a 

computer, a dialog box for the Temporary License Authorization appears, as shown below. 

This allows you to use P View immediately, for up to 30 days while you are completing the 

registration process or for product evaluation and trial purposes. 

4. To execute the temporary license, click Yes. If you want to transfer a license to the PC, click 

No. If you want to continue to run in demonstration mode, click Exit.

5. Clicking Yes enables the temporary license, and the License Utility will open

Note! 

• Please refer to the Endress+Hauser Software Licensing or Getting Started Help documentation on 

the P View product CD for details about registering, authorizing, transferring, and terminating an 

Endress+Hauser software license.
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4.3.2 Registering for a Software License

To authorize a permanent license, you must get a Site Key, which is a unique "software key" number 

that unlocks the runtime licenses for your site. There are two options to register and obtain a Site 

Key for the PC running the License Utility. Regardless of the method selected, the registration and 

license of P View product(s) is achieved using the following process:

Procedure 1. Endress+Hauser validates the purchase of the products to be installed by using the provided 

Serial Number shipped with the purchased CD.  Once validated, Endress+Hauser generates 

and returns a corresponding Site Key number that will activate the proper products for use on 

this PC.

2. Select Authorize License from the Actions menu, and enter the provided Site Key number in 

the P View License Authorization dialog box to activate the license:

3. In the License Utility, begin the process of obtaining your site key by selecting Register for a 

License from the Actions menu. 

4.3.3 Fax/E-mail Registration

1. After selection of Register for a License the P View Registration Information dialog 

appears, as shown below. The Site Code generated for your computer by the License Utility is 

displayed at the bottom. Enter your name, address, city, phone number, etc., in this dialog box, 

and then click OK. The License Utility automatically saves this FAX and/or e-mail information 

into the Registration file (Register.dat) in the path where you have installed the License Utility.

2. Finally, the P View Registration Process Completed dialog box is displayed, as shown below. 

You may now choose which method you prefer to use to send your information to 

Endress+Hauser (pview@solutions.endress.com).

3. After receiving this information from you, Endress+Hauser will provide you with the unique 

Site Key for your system via fax or e-mail.  Once you have your Site Key, you can authorize 

your software license, see Section 4.3.4.
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4.3.4 Authorizing the Software License

Once you have your Site Key (from either the Web site or from the fax/e-mail form received from 

Endress+Hauser), you are ready to authorize your license. 

1. Select Authorize License from the Actions menu of the License Utility, the P View License 

Authorization dialog box appears:

2. This dialog box displays your Site Code

– Type the Site Key number received from Endress+Hauser in the Site Key field

– Click Update to have your license authorized. 

3. You can now view the enabled software license by selecting View License from the Actions 

menu bar of the License Utility

Note! 

• If you had an existing license to begin with, clicking Update will overwrite your existing license, 

either by replacing or appending/updating it with new products.

4.3.5 Viewing the Software License

To view the software license, select View License from the Actions menu of the License Utility. 

This opens the P View License View dialog box, shown below, which displays the current license 

information, including:

• Type of license

• Restrictions on the license

• Number of copies licensed (allowed and used) 

• Number of Clients Units supported by the license 

• Site Code and Site Key

If the license is temporary, the Site Key field will display Temporary Authorization, and there will 

be a unique Site Code generated by the utility based on your computer hardware.
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4.4 Pocket P View

Users of Pocket P View must purchase licenses for simultaneous connections between a desktop PC 

and Pocket PCs. When a user purchases Pocket P View and installs it on a desktop PC, two 

simultaneous Pocket PC connections will be available to that user from the desktop PC. If the user 

decides that more Pocket PC connections are needed, the user must purchase more Pocket PC 

connections in packages of five connections.

The P View License Utility detects how many Pocket PCs are connected to the desktop PC. If the 

maximum number of connections has been made, no new connections will be allowed to the 

desktop PC. For example, during one connection a Pocket PC can be running Pocket P View Trend, 

Pocket P View Alarm, and Pocket P View Graph simultaneously. If any of those applications are 

running, the connection is active.

For Pocket PCs, the License Server runs on the desktop PC connected over Ethernet via P View 

Broker. Thus, if a user has a license that allows for two connections and has two Pocket PCs 

connected at the same time, both Pocket PCs can be running Pocket P View Trend, Pocket P View 

Alarm, and Pocket P View Graph simultaneously. Then if another Pocket PC tries to connect to the 

P View Broker server on the desktop PC where those two licenses are located, it will be denied.

Note!

• Please refer to the P View Broker help documentation for information about assigning a node or 

IP address to a remote License Server.

• Please refer to the Endress+Hauser CD documentation for information about licensing for P View 

Report and other optional modules.
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4.5 Transferring a Software Key License

You can use either a floppy disk or the Web Licensing Site to transfer a license.  You can transfer a 

software license from one PC to another, or a single copy of the software license if multiple copies 

exist on the same PC. The License Utility must be installed first on the target PC, so you can perform 

the license transfer. 

Transferring Licenses 

Using a Floppy Disk

License transfer requires that the target PC is an unauthorized site. To transfer a license from one 

PC to another, do the following:

1. On the target computer, select Transfer License from the Actions menu of the P View License 

Utility to generate registration files on a floppy disk. This opens the P View License Transfer 

dialog box:

2. At the target PC, a floppy disk has to be prepared for receiving a license. Format the floppy disk 

using the target computer. If you do not have a formatted floppy disk, you can quit the License 

Transfer dialog box and run it later.

3. Select the Destination PC which is about to receive the license option on the License Transfer 

dialog box. Notice that Step 1 of the dialog box is enabled. The path will default to A:\. If your 

floppy disk drive letter is different, you can type it in the path field (for example B:\).

4. Click the Register Transfer button. This will prepare the floppy disk for transfer.

5. Insert the prepared floppy disk in the source computer and run the License Utility. Select 

Transfer License from the Actions menu of the License Utility and select the Source PC which 

already has license installed option. Notice that Step 2 in the dialog box is now enabled. The 

path will default to A:\. If your floppy disk drive letter is different, you can type it in the path 

field (for example B:\).

6. Click the Transfer License Out button on the dialog box. This will transfer the license from 

the source PC to the floppy disk.

7. Select Transfer License from the Actions menu on the target computer to transfer the 

license from the floppy disk to the target computer.

8. Click the Transfer License In button now. This will transfer the license from the floppy disk 

to the target computer.

9. Restart your target computer for the changes to be effective.

Transferring Licenses 

Using the Web Site

You can transfer a license by first killing it (described in the next section) on one PC in conjunction 

with the Web Authorization Site (thereby putting the license back onto the Web), and then re-

authorizing it on the new PC.  The Web site acts as an intermediary storage facility for the license, 

making it easy to transfer licenses between PCs that are physically far apart.

You must contact Endress+Hauser Process Solutions AG, before using this facility.
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4.6 Killing a Software Key License

To kill or delete the existing software license:

1. Select Kill License from the Actions menu in the License Utility. Using this option, you can 

remove the current software license from the current machine. You also need to contact 

Endress+Hauser to get a special password for killing your license. A warning message will be 

displayed on the screen as shown below. If you kill your license, you need to get a new license 

from Endress+Hauser to restart your P View product.

2. Click OK to continue or Cancel to exit. Clicking OK will display another warning message. If 

the license you are killing is an authorized time-limited license, a message appears.

3. If the license you are killing is a 30-day license or a permanent license, a differrent message 

appears:

4. Clicking OK will display the Kill and Remove License dialog box, as shown below. Click 

Cancel if you do not want to continue. Enter your name, the date, and the password you 

received from Endress+Hauser to kill the license on the above dialog box, and then click OK. 

Click Cancel if you do not want to kill your license. 

Note! 

This is the last step before you can exit without killing your license. 

5. A dialog box will appear to warn you of this danger, as shown below. If you wish to proceed 

with killing your license, click OK.
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6. A dialog box containing the Kill Confirmation Code will appear, as shown below. Click OK.

Note! 

You can copy the code in the Kill Confirmation Code field and paste it onto the Web page.  

7. Upon successful deletion, a file called "KILL.TXT" will be created in the "Softlic" directory, 

which has the name, date, and last authorized key and confirmation code. A message will 

appear informing you that the file has been created:

Keep this file! You will have to use the name, date, and last authorized key and confirmation 

code that it contains to confirm that you've killed your license.  

Note! 

• If you uninstall the Software License Utility, it will delete this KILL.TXT file. So make sure to copy 

this file or note the confirmation code before uninstalling the Software License Utility. You also 

need to give this code to Endress+Hauser for the license removal process to be complete.

• Also, a time-limited license CANNOT be credited back using a Kill Code. You must call 

Endress+Hauser.

• Simply uninstalling P View Enterprise Software (or its components) will not uninstall the 

Licensing software. Your valid license will remain activated on your PC.
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4.7 Site keys and file maintenance

The software Site Key handles licensing of P View without requiring a hardware protection key. 

Licensing encrypting information is stored deep within the Windows systems. If no P View 

authorization is present, it will automatically run in Demo mode for two hours.

Note! 

• Set the System Date and Time properly before installing the Endress+Hauser License Utility. 

Changing the time and date may affect time-limited Licenses.

Upon successful installation of P View, the installation wizard automatically creates a directory for 

the P View Software Key licensing system. By default, the files are copied to the following path: 

…Endress+Hauser\P View Software Licensing

This directory contains the GENLIC32.exe utility used for any P View system licensing transactions 

along with the Licensing files themselves.

Note! 

• Tampering with the installation directory or P View files might accidentally destroy the license.

The "P View Software Licensing" directory also contains the following files among others:

• GENLIC32.RST

• GENLIC32.ENT

• GENLIC32.KEY

• GENLIC32.KY2

• GENLIC32.41S

These files give the user a license to use P View, and they contain encrypted information relating to 

the PC used, options the user is allowed to activate, and file system/directory.  If the P View 

directory is renamed after the license has been granted, the software protection key will NOT 

recognize the license under the new directory name. It is also advisable not to tamper with the 

system's clock if using a time-limited license.  Setting the time back more than one hour will 

invalidate the license.

Note! 

• Ensure there is at least 1 MB of free disk space at all times on the hard drive the license is installed 

on.  If the disk becomes completely full, the software license may be lost.

• If you are using Norton Speed Disk to reallocate disk clusters, the following procedure must be 

followed to prevent loss of the P View Software License.

1.Open Speed Disk and choose File > Options > Customize > Unmovable Files.

2.Specify that the *.ent, *.rst, *.key, *.ky2 and *.41s files cannot be moved.
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5 P View Demo

The P View Demo is a set of P View Graph (.gdf) display files installed with your system to help you 

learn and test your new software.  The Demo contains the following:

• Online Product Tutorial

• Technology Training

• Corporate Information

• Project Examples

• Other Miscellaneous Files

Although this chapter only gives a quick overview of this demo, you are strongly encouraged to 

explore all of the files contained within the project.  By switching to Configure mode in P View 

Graph, you can explore how the display was created and the dynamics and connections used.

Note! 

• For complete information about the P View Demo with additional screens, please see the Getting 

Started Help documentation on the P View product DVD

5.1 Starting the P View Demo

By default, the files used by the P View Demo are installed in the Endress+Hauser\

P View\Examples\GEN32DEMO directory, which is also set as your default working directory 

when you first install and run the P View software. P View Demo uses P View Graph, the HMI 

graphics software module of P View, as the "engine" for giving the presentations. 

To launch the P View Demo:

From the Windows Start menu, select Programs > Endress+Hauser > P View > P View Demo. 

This will open the P View Demo home page (Home.gdf) display file in P View Graph in Runtime 

mode, as shown below.
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5.2 Navigating the Demo

The main navigation tools in the P View Demo are contained within the border.  Each button is 

explained below. Clicking on the ControlCare hand takes you to an overview screen from which 

information on the various components of ControlCare P View can be called.

Navigation arrows and 

buttons

The menu bar of the P View demo contains a number of icons which are used as shown in the table 

below:

Operation When you first click on the Home button, it opens a Demo Screen Sequence List showing all the 

files used in the current sequence being used by the P View Demo (this list is stored in the file 

"DisplayList.txt" file).

Select which file you wish to go to from the list and then click the Open button (or simply double-

click on the file name). 

Clicking on the Select a Different Presentation Sequence button opens a dialog asking which 

other presentation you wish to use.  Additional details on these, and on creating your own, can be 

found in the ReadMe file that comes with the P View Demo.

Icon Buitton Meaning

Forward Arrows • Use the Small Forward Arrow as a Display Forward button, working much 

like the forward button in Microsoft Internet Explorer. 

• Use the Large Forward Arrow to browse forward through the defined demo 

sequence.

Backward Arrows • Use the Large Backward Arrow as a Display Back button, working much like 

the Backward button in Microsoft Internet Explorer. 

• Use the Small Backward Arrow to browse backwards through the Demo 

sequence

Note: If you are simply going through the demo screens in sequence without 

jumping around, then the two buttons operate in a similar fashion.

Home • Clicking on the Home button takes you back to the start of the demo sequence 

(the Home.gdf display) from wherever you may be in the Demo sequence

List • Clicking on the List button allows you to jump to any display used in the 

demonstration sequence.  You can also use it to change which presentation 

sequence the P View Demo will use.

Industry Examples • Clicking on the Industry Examples button takes you to a series of example 

screens.  Additional details are provided later in this manual.

Learning Centet • Clicking on the Learning Center button takes you to the Tutorial section of the 

P View Demo.  See the details in the following section.

Help • Clicking on the Help button, as shown below, opens a pop-up menu with links 

to the P View Demo Help screen, as well as the P View Getting Started Help 

documentation and the P View product help files
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6 P View Quick Start

The Getting Started Help documentation on the P View product DVD provides the following "quick 

start" tutorials to help you get started with your P View projects:

• OPC Simulator Quick Start

• Graph Quick Start

• Trend Quick Start

• Alarm Quick Start

This chapter only provides a brief overview of these tutorials.  To follow along step-by-step with the 

full versions of the quick starts, please see the P View Getting Started Help documentation on the 

P View product DVD.

6.1 OPC Simulator Quick Start

P View "Plugs and Plays" with the powerful open communication architecture of OPC (OLE for 

Process Control). An overview of OPC can be found in Chapter 2.

Since there are hundreds of OPC servers available, each with variations on the steps for using their 

configuration tools, it is not possible to provide exact details for the specific server you will use for 

your project. Instead, the OPC Simulator Quick Start provides a step-by-step guide for creating 

OPC tags using the Endress+Hauser Simulator OPC Server. The Simulator OPC Server should 

already be installed on your machine in conjunction with P View. If it is not on your machine, you 

may install it from the P View DVD. 

Although you will ultimately use the actual OPC server connected to your real I/O, you should still 

complete the steps presented in the OPC Simulator Quick Start. To follow along with these steps, 

please see the P View Getting Started Help documentation on the P View product DVD.

Procedure 1. To launch the Simulator from the Windows Start menu, select 

Programs > Endress+Hauser > P View > Tools > Simulator OPC Server

2. The configuration screen for the OPC Simulator opens:

Note : there are definitions already created for this server.  Various portions of the P View 

Demo use these tags.  As such, you should leave these configurations intact so the various 

examples used in the P View Demo will function properly.

The names in the left pane of the window (e.g. Disk IO, Global Variables, Recipe Storage, 

Simulate PLC) represent simulated "devices."  In the real world, "devices" could mean 

"Programmable Logic Controllers (PLCs)," "I/O Boards," or "Sensor Networks," etc. 

3. Now use the OPC Simulator Quick Start to walk you through the following:

– Starting a new OPC Simulator project

– Creating a simulated device

– Creating groups

– Creating tags
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6.2 P View Graph Quick Start

This chapter serves as a "mini-tutorial" for P View Graph, the HMI module in P View.  There are 

dozens of tools with hundreds of parameters and combinations to create powerful graphics.  The 

intent of this chapter is not to go through every combination and permutation, but to walk through 

a few fundamental concepts at least sufficient enough to get a project started.

The Trend Quick Start and the Alarm Quick Start also build on the example screen developed in 

the Graph Quick Start, showing how to add live trending of data and alarm information.  To follow 

along with the steps in the Graph Quick Start, please see the P View Getting Started Help 

documentation on the P View product DVD.

Note! 

• For additional information on using P View Graph, please refer to the P View Demo tutorials (see 

Chapter 5) or the P View Graph Help documentation available on the P View Product DVD. 

Procedure An example P View Graph project has already been created as a starting point for this Quick Start 

tutorial. The display file, called QuickStartWalkThru.gdf, is installed in the Endress+Hauser\P 

View\Examples\DEMO directory.

1. To start the project, first launch P View Graph from the Windows Start menu by selecting 

Programs > Endress+Hauser > P View > Graph > Graph.

2. In P View Graph, select Open from the File menu, shown below. 

3. Browse to the Endress+Hauser\P View\Examples\GEN32DEMO directory and open 

the file QuickStartWalkThru.gdf

4. The display, shown below, already has the P View Demo template applied (the top and left 

border with the navigation buttons, scalable settings, etc.), as well as a number of objects 

already configured

5. Now modify the display to show live values coming from the Simulator OPC Server, using the 

tags created in the OPC Simulator Quick Start. The Graph Quick Start walks you through the 

steps for configuring the dynamics for this display, including:

– Process points 

– Runtime mode

– Location dynamic

– Rotation dynamic

– Color dynamic

– Writing values to OPC tags
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6.3 P View Trend Quick Start

P View Trend is the Data Logging and Trending module in P View.  There are actually several 

components that make up this software package:

• SQL Data Logger

• Data Logging Configurator

• Persistent (Background) Trending

• Trend Viewer ActiveX for Live and Historical Trending

• Database Reporting Tools

Within each of these components are dozens of tools with hundreds of parameters and 

combinations to satisfy a wide range of applications.  The intent of this chapter is not to go through 

every combination and permutation, but to walk through enough fundamental concepts of the 

P View Trend Viewer ActiveX to get a project started.

Note! 

• For additional information on using P View Trend, please refer to the P View Demo tutorials (see 

Chapter 5) or the P View Trend Help documentation available on the P View product DVD. 

The Trend Quick Start builds on the QuickStartWalkThru.gdf Graph display developed in the 

Graph Quick Start, showing how to add live trending of data to that display. To follow along with 

the steps in the Trend Quick Start, please see the P View Getting Started Help documentation on 

the P View product DVD. To start the project. 

Procedure 1. If it is not already running, open the QuickStartWalkThru.gdf file in P View Graph.

2. The Trend component for plotting live and historical data graphically on the screen is actually 

an ActiveX component.  It is therefore available not only within the Trend container 

application, but in any ActiveX container.  In Graph, insert the Trend Viewer ActiveX into the 

display by clicking on the TWXView32 button on the ActiveX toolbar

3. A trend window is placed on the screen, as shown below.  

Shrink it down and move it to fill in the right hand section of the screen. It is easiest first to 

move it so the lower right corner is at the desired location, and then simply use the upper left 

resize handle to position the opposite corner.

4. Now use the Trend Quick Start to walk you through the steps for configuring the trend 

viewer for this display, including:

– Dragging and dropping data sources

– Manipulating trends during runtime

– Configuring the trend viewer properties

– Dragging and dropping data sources
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6.4 P View Alarm Quick Start

P View Alarm is the alarm monitoring, logging, and reporting module in P View. There are several 

components that make up this software package. Within each of these are dozens of tools with 

hundreds of parameters and combinations to satisfy a wide range of applications:

• Alarm Server Configurator: Creates alarm definitions 

• Alarm Server: Main engine for monitoring alarms

• Alarm Logger Configurator: Defines which alarms get logged to a database and/or printer

• Alarm Logger: Print and log to a database 

• Alarm Container: Provides a container for the Alarm Viewer ActiveX (helpful for stand-alone 

applications)

• Alarm Viewer ActiveX: Plug-in that shows live alarms

• Alarm Report ActiveX: Plug-in that shows historical alarm information from the logged 

database

• Alarm Indicator ActiveX: Monitors alarm activity from virtually anywhere on your computer 

display

Alarm Multimedia (optional): Plug-ins for enunciating alarms using multimedia "agents," including 

pager, telephony, e-mail, fax, marquees, text messaging, and task tray

Note! 

• For additional information on using P View Alarm, please refer to the P View Demo tutorials (see 

Chapter 5) or the P View Trend Help documentation available on the P View product DVD. 

This chapter builds on the example screen developed in Chapters 6.2 and 6.3, showing how to add 

a live alarm viewer to that display.  

Procedure 1. If it is not already running, please open the QuickStartWalkThru.gdf file in P View Graph.

2. The P View Alarm component for showing live active alarms in a table is actually an ActiveX 

component.  It is therefore available not only within the P View Alarm container application, 

but in any ActiveX container.  In P View Graph, the P View Alarm Viewer ActiveX can be 

inserted into the display by clicking on the AWXView32 button on the ActiveX toolbar, as 

shown below.

3. An alarm window is placed on the screen.  Move it and resize it to fill up the bottom section of 

the screen, as shown below. It is easiest to move it first so the lower right corner is at the 

desired location, and then simply use the upper left resize handle to position the opposite 

corner.  Save the display file.

4. Now use the Alarm Quick Start to walk you through the steps for configuring the alarm 

viewer for this display, including:

– Creating an alarm view

– Alarm viewer runtime operation

– Configuring the alarm viewer properties

– Configuring an alarm tag
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6.5 P View Scheduler Quick Start

P View Scheduler is a scheduling management program to control many of industries' needs for 

scheduling automation, such as controlling building lights, HVAC, machine operation time, and 

many others.

Scheduler and UDM operate under the same single configuration file. Unlike other modules of 

P View that uses separate configuration file, Scheduler will store all of its schedules, value sets, and 

holiday information in the same configuration file that is used by UDM. With this in mind, when 

you open Scheduler, any configuration that is currently active in UDM will be loaded automatically.

A schedule is where you put in your events. By assigning valueset to a schedule, you will be able to 

modify each valueset's behavior for a specified events. You can create weekly recurring schedule, 

exceptions, and holiday events.

Procedure 1. To launch Scheduler click 

Start > Programs > Endress+Hauser > P View > Scheduler > Scheduler

2. To create a new schedule right click on the Schedule in the tree-control, and select 

New > Schedule.

3. Enter your events, and save the file.
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7 P View Utilities

In addition to the core products of Graph, Trend, and Alarm, many other important tools and 

utilities are also installed with P View. This chapter briefly introduces some of these utilities. For 

more information, please refer to the Help documentation on the P View product DVD.

7.1 Security Server

The Endress+Hauser Security Server provides a variety of options for restricting operator actions 

during runtime, including:

• Which points they can write to (change value).

• Critical points.

• Which files they can open.

• Time sheets for defining when they can log in.

• Password management.

• Workstation access for logging in.

• Client application action restrictions.

For additional information, refer to the Security Server Help documentation on the P View 

product DVD

7.2 Monitor

The Monitor Viewer is a tool that provides graphical monitoring and a centralized diagnostics area 

for many aspects of your P View applications, including:

• Applications and Services

• Licensing

• Redundancy 

• Runtime

Key features of Monitor include:

• Look and feel of the Unified Data Browser.

• Movable split bar separating the tree control from the item viewer.

• Shows runtime information for active servers.

• Centralized diagnostics tool for P View components.

• Starts and stops applications and services (serves as a replacement for the P View Tray 

application).

• Provides licensing information and duplicate license detection (serves as a replacement for the 

License Monitor application).

• Displays the runtime status of redundant node pairs (support for redundancy in Data Collector 

Professional Edition). Also allows you to designate (in real time) which node in a redundant 

node pair is the active node and which node is the standby node.

• System tray provides visible "bubble" notifications.

For additional information, please see the Monitor Help documentation on the P View product 

DVD.
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7.3 P View Broker

P View provides a utility called P View Broker to assist with projects using a set of applications 

networked together. There are many options and configurations possible. As with other chapters in 

this "Getting Started" manual, this section covers just some basics to get a project pointed in the right 

direction. 

The P View Broker Configurator is a tool that enables you to customize your network architecture. 

The P View Broker Configurator allows you to:

• Specify the communication method.

• Configure the P View Broker Client.

• Configure the P View Broker Server.

• Assign nodes to direct channels.

• Assign mediator nodes for indirect channels.

• Specify the default channel.

• Add and remove nodes or IP addresses.

• Configure channel properties.

• Specify the location of primary and redundant remote servers.

The configuration settings are saved in a P View Broker configuration (.gbx) file. You can store 

multiple configuration files. Configuration files tell P View Broker Server how to communicate 

when it interacts with various clients.

For additional information, please see the P View Broker Help documentation on the P View 

product DVD.

7.4 P View Trace

Using a technology that has been incorporated into all Endress+Hauser products, P View Trace 

provides online diagnostics and tuning of applications running in the P View system. Trace is 

designed for systems integrators, OEMs and customers who want to have tools for doing their own 

troubleshooting and diagnostics. 

For additional information, please see the Trace Help documentation on the P View product DVD.

7.5 P View Project

P View contains numerous applications with multiple components, requiring a well-trained user in 

order to successfully create, integrate, deploy, and manage projects. Each of these components 

requires complex setup of many different types of configuration files, databases, and OPC servers, 

as well as runtime and security settings. To simplify project management and deployment, 

Endress+Hauser has introduced P View Project, which integrates all P View applications into a 

single, easy-to-manage format. The P View Project user interface is basically a container embedded 

in the Microsoft Management Console (MMC). The P View Project console conveniently 

• Organize all application files into separate projects.

• Create new application files and OPC configurations.

• Import application files into projects.

• Start and stop P View applications.

• Pack project files into a single, compressed file, and unpack project files for easy deployment 

to multiple computers. 

• Activate entire projects into runtime mode.

• Password-protect projects security settings.

• Back up project files.

• Publish projects to the Web.

• Generate comprehensive reports for all files and projects.

For additional information, please see the P View Project Help documentation on the P View 

product DVD.
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7.6 P View VCR

P View VCR is a powerful tool in P View that enables the replay and reanimation of graphical, 

historical and alarm data. 

For additional information, please see the Unified Data Manager Help on the DVD.

7.7 Unified Data Manager

The Unified Data Manager enables the centralized management of commonly used expressions, 

value sets, tag groups, alarm subscriptions, alarm filters, recipes, and event triggers across P View 

products as well as other Endress+Hauser products.  From an easy-to-use interface you can create 

libraries of reusable expressions, value sets, recipes and other functions. The Unified Data Manager 

provides time-saving, on-the-fly selections and modifications of commonly used functions, saving 

integration and applications development time. 

For additional information, please see the Unified Data Manager Help on the DVD.

7.8 Script 2006

Script Tools has undergone some major changes from P View Script Tool to Script 2006.  P View 

Script Tool is still included with P View Version 9, so P View Script Tool configurations from earlier 

versions will not need to be updated, but the many advantages of Script 2006 will most likely 

convince you to use it for new applications.

Script 2006 allows you to create and run custom scripts.  These scripts are written in Microsoft 

Visual Basic for Applications (VBA), and are run as multithreaded objects.  The Script 2006 

Configurator indicates what type of script is being created and how it will be executed.  User-

defined VBA scripts can perform OPC read-and-write operations to any OPC server, which 

interfaces to factory floor devices, such as PLCs and other OPC-compliant servers.  Script 2006 

simultaneously performs calculations, manages databases, and executes any operation available in 

the VBA language to access reports or perform recipe operations. Script 2006 also offers project-level 

scripting. Script 2006 takes advantage of the new Unified Data Manager with its extensive 

centralized support for triggers. VBA scripts can be scheduled and configured for execution, and can 

be triggered based on OPC Data Access, OPC Alarm and Events, and file events. 

For additional information, please see the Script 2006 Help documentation on the P View product 

DVD.

7.9 Data Collector 

Data Collector provides OPC-server-to-OPC-server data bridging, OPC aggregation, OPC 

tunneling, and mission-critical OPC-based redundancy. Unique data-bridging technology allows the 

connectivity of any OPC server to any other OPC server, providing Plug and Play interoperability. 

This enables you to connect two different OPC servers and share data easily and seamlessly. Data 

can also be manipulated through expressions and calculations.  For additional information, please 

see the Data Collector Help documentation on the P View product DVD.

7.10 P View Data Mining

P View data mining enables visualization of data from various data sources, such as a Microsoft 

Access, in a customizable display format that enables users to interact with and manipulate data. 

The Data Mining Configurator establishes connections with data sources that can be mined from P 

View applications, such as Graph, where users can visualize data. 

For more information, see the Data Mining Configurator documentation on the DVD.
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7.11 SNMP Configurator

Today's factory automation systems must integrate information from different infrastructures 

reliably and in real-time. To assist with integration, P View enables users to integrate OPC, SNMP 

(Simple Network Management Protocol), and databases with real-time data mining. 

Endress+Hauser's native SNMP network management and analysis capability was specifically 

developed for the industrial controls marketplace to seamlessly integrate monitoring and analysis of 

a wide variety of managed and unmanaged Ethernet devices into all Endress+Hauser products. 

For additional information, please see the SNMP Configurator documentation on the P View 

product DVD.
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8 Help and Technical Support

8.1 Online Help 

Endress+Hauser software provides online help with descriptions and explanations of each 

application. Help is available from the Help menus and within most dialog boxes. You can access 

help from the following:

• Select Help Topics from the Help menu of the current application. This opens the help file for 

that application. To search for a topic in the help file, click the Find button and go through the 

Find Setup Wizard. Type or select the term you want to find, and then click on the topics 

that are displayed for that term.

Note! 

• Most help (.hlp) files for P View are installed in the Program Files\Endress+Hauser\

P View\Bin directory. Each help file has an accompanying table of contents (.cnt) file. If the Find 

Setup Wizard fails to initialize when you try to execute a search operation in a help file (as 

described above), close the help file and then delete any .fts, .ftg, and/or .gid files from the Bin 

directory. Then reopen the help file and try to run the search again.

– Click on the Help button (or press the F1 key) in any dialog box to display context-sensitive 

help for that dialog box.

– Move the mouse pointer over an icon and pause for a moment to display pop-up ToolTips 

for quick help for that object.

– Adobe® Acrobat® PDF files of all P View product documentation are also included on the 

P View product CD in the Documentation section.

Note! 

• For subscribers to the Endress+Hauser Knowledge Base, PDFs of the product documentation are 

also available on the Endress+Hauser Web site at www.endess.com/support/documentation.asp.

– To access general information and the latest software enhancements, open the P View.txt 

file in the directory where you installed the program files (default location is Program 

Files\Endress+Hauser\ P View).

– Run the P View Demo (refer to Chapter 5), which offers an online tutorial, as well as many 

examples from which to learn.

– Additional example files are also installed in the Program Files\Endress+Hauser\

P View\Examples directory, providing another source for help on using P View and its 

components.

Note! 

• Refer to your Microsoft Windows documentation for complete information about using the 

Microsoft Help functions.
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8.2 Training Classes

P View training classes are held at regular intervals at the Endress+Hauser training facility in 

Reinach. The current schedule is available on the Endress+Hauser Web site at www.endress.com/

support/training.asp.

The P View Training course is intended for first-time P View users and those unfamiliar with HMI/

SCADA software. Additional topics are covered in our advanced training classes. To reserve seats in 

training courses, please contact our training coordinator at +4161 715 7378.

On-site training seminars are available for customers who want to hold a custom training class at 

their facility. A maximum of 12 students is recommended. Please contact Endress+Hauser for dates 

and pricing.

8.3 Technical Support

After reading the manuals and using the related online help, if you still cannot solve a P View-related 

problem, contact Endress+Hauser Technical Support for assistance. Endress+Hauser is proud to 

provide our customers with the highest quality customer service available in the SCADA industry 

today. 

8.3.1 P View Support

We value your project and understand that full, comprehensive support is just as important to you 

as the high-quality product you have purchased from Endress+Hauser. This is why we offer P View 

technical support service plans that meet your technical support needs. These plans allow you to 

access support engineers, receive product upgrades, and obtain a wide variety of valuable services 

that will benefit both you and your customers. 

8.3.2 Telephone Support

Endress+Hauser has call centers at its Sales Centers around the world.  Support is available Monday 

through Friday, year round, except for the observance of local holidays and official Endress+Hauser 

holidays.  Endress+Hauser support centers handle calls on a first-come, first-served basis. Calls are 

usually answered immediately during normal business hours. A check for the telephone numbers of 

your local Sales center by visiting your national Endress+Hauser web site via

• www.endress.com > Worldwide or

• www.xx.endress.cam, where xx is the national symbol, e.g. de for Germany. 

To ensure your case receives prompt attention, please have the following information available 

when calling: 

• A PC available for tests and diagnostics

• The product documentation, in case the support engineer needs to point out some settings

• A clear understanding about the issue and how it is reproduced.  Please be sure you will be 

able to answer some basic questions about the application and software

• The version of your operating system and the installed Endress+Hauser product(s)

• OPC server or any relevant third-party software information.

8.3.3 E-mail Support

The Endress+Hauser e-mail support address is service@solutions.endress.com.
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9 Error Messages

This chapter provides a list of possible causes and solutions for system problems you may encounter 

while using P View Software.

If the information provided here does not solve your problem and you have installed the system 

according to the "Getting Started Reference Guide" procedures, contact Endress+Hauser Technical 

Support. Please refer to Chapter 12 in this "Getting Started" manual for more information on 

Technical Support.

9.1 P View installation errors

9.2 Expression Errors

Message Meaning

Endress+Hauser About Box Automation Server 
is not registered!

The installation of P View failed to register the About Box Automation 
Server. Restart your computer and try the installation again. If the 
problem persists, contact Endress+Hauser Technical Support

Endress+Hauser Tag Browser Automation DLL 
not registered!

The installation of P View failed to register the Tag Browser Automation 
Server. Restart your computer and try the installation again. If the 
problem persists, contact Endress+Hauser Technical Support.

Message Meaning

Syntax Error: Unknown number format A number was specified in the expression, but in an invalid or unknown 
format

Syntax Error: No end tag token A start tag token ({{) was found, but no matching end tag token (}})

Syntax Error: No end local variable token A start local variable token (~~) was found, but no matching end local 
variable token (~~)

Syntax Error: Unknown function An unknown function name was specified in the expression

Syntax Error: Unknown operator An unknown operator was specified in the expression

Syntax Error: No tag name Start and end tag tokens were found with no tag name specified between 
the tokens

Syntax Error: No local variable name Start and end local variable tokens were found with no local variable 
name specified between the tokens

Syntax Error: Missing left parenthesis A right parenthesis was found with no matching left parenthesis

Syntax Error: Missing right parenthesis A left parenthesis was found with no matching right parenthesis

Syntax Error: Incorrect number of parameters The wrong number of parameters was specified in a function used in the 
expression

Syntax Error: Unexpected token An unspecified syntax error exists in the expression

Syntax Error: No end string constant token A start string constant token ($") was found, but no matching end string 
constant token ("$)

Syntax Error: No end alias token A start alias token (<<) was found, but no matching end alias token (>>)

Syntax Error: Old shift operator unsupported. 
See shl() and shr()

Old Shift operators (<< and >>) are no longer supported for expression 
configuration.  
Use shl() and shr() functions instead
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9.3 Language Support

9.4 P View Graph

Message Meaning

The selected language resource does not have 
the appropriate version number

Please obtain an updated version of the file: <FileName>

The selected language translation is not 
available

This error message appears when you attempt to change to a language for 
which there is no available language resource file.

Message Meaning

Unexpected file format This error occurs if the format of the file you are attempting to open is 
not valid for this version of P View Graph.  This message will appear if 
you attempt to open a file that is not a P View Graph display file.  This 
message will also appear if you attempt to open a display file created in a 
newer version of P View Graph than the version currently being used to 
open the file.  For instance, using an earlier version of P View Graph, you 
cannot open displays files created with a later version (the newer format 
cannot be understood by the older P View Graph)

Failed to open document This generic error message appears when a P View Graph display fails to 
load.  Reasons for the failure vary, depending on the situation.  One 
possible cause is that the P View Graph display contains ActiveX controls 
that are not properly registered

Failed to save document This error occurs when you try to save a read-only file

Failed to create empty document This error typically occurs when P View Graph is unable to start up 
properly.  This can occur when certain Windows resources are low or 
have run out

Failed to create object. Make sure the object 
has been entered into the system registry

This error can occur when you attempt to insert an ActiveX control that 
has not been properly registered

The selected language resource does not have 
the appropriate version number.  Please obtain 
an updated version of the file: <Filename>

This error message appears when you try to change P View Graph's 
language if the version number of P View Graph and that of the language 
resource file for the selected language do not match.  These version 
numbers must exactly match to load the language successfully.  You can 
check the version number of P View Graph by opening the About box 
and the version number of the language resource file by right-clicking on 
the file in Windows Explorer and choosing the Properties option from 
the pop-up menu

The selected language translation is not 
available

This error message appears when you attempt to change P View Graph 
to a language for which there is no available language resource file

License Failure This message occurs if P View Graph is unable to connect to the 
Endress+Hauser licensing server.  This can occur if the licensing server 
(GenRegistrarServer.EXE) is not properly registered

Insufficient Security Level This message appears in Runtime mode when the user currently logged 
into the Endress+Hauser security system does not have permission to 
perform the command that has just failed.  This message can also occur if 
P View Graph is unable to connect to the Endress+Hauser Security 
Server.
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9.5 P View Trend

9.5.1 Trend Viewer ActiveX

Message Meaning

Security Server Timed Out! Both TWXViewer and TWXBgTrend display a dialog box saying this. You 
are running the software in Demo mode or a Time Limited mode (e.g., 
Temporary License mode). Install a proper license

No protection key has been found or the demo 
period has expired

A message that appears in TWX Viewer. You are running the software in 
Demo mode or a Time Limited mode (e.g.,  Temporary License mode). 
Install a proper license

Message Meaning

Insufficient Security Level! It appears when you attempt to perform an operation within the ActiveX 
Control without having the required security attributes in the P View 
Security Server

The selected language translation is not 
available

It appears when you try to switch languages, and the ActiveX Control 
does not find the required language resource DLL

Please Enter A Valid Range Value! It appears when you try to enter an invalid High or Low Range value or 
string on editing range information

A search string must be specified It appears when you try to perform point replacement operations without 
specifying a search string

A replace string must be specified It appears when you try to perform point replacement operations without 
specifying a replace string

Error in Saving Info... It appears when an error occurs while you try to save to a file statistical 
information from the signals displayed in the Trend ActiveX

Cannot switch trend mode. Modify 
Connections First!

It appears when the Trend ActiveX has been configured for a History 
Only replay in Freeze mode and you try to connect real-time pens or, if 
real time pens exist, you try to select Frozen Historical replay

Please Enter A Valid Alarm Value! It appears when you try to enter an invalid High or Low Alarm value on 
editing pen alarm  information.

Please Enter A Valid Point Name It appears when you try to edit a pen configuration and there is no point 
(signal) name entered for the pen

Please Enter A Valid Description Text It appears when you try to edit a pen configuration and no description 
text has been entered for the pen

Failed to Create Toolbar! It appears when the Trend ActiveX fails to create its floating toolbar upon 
entering Runtime mode

Failed to Create CMiniFrameWnd! It appears when the Trend ActiveX fails to create its miniframe window 
required for its floating toolbar upon entering Runtime mode

Cannot delete XY Plot X-axis in Animate mode It appears when you try to delete a pen designated as the X-axis pen in 
an XY-Plot

Error opening Tag Browser It appears when the Trend ActiveX cannot load the Endress+Hauser Tag 
Browser. Make sure that the Tag Browser has been properly installed and 
registered

Error Opening About Box It appears when the Trend ActiveX cannot display the About box 
information. Make sure that the Endress+HauserAbout.dll has been 
properly installed and registered
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9.5.2 Persistent Trending

Message Meaning

No Group Name Selected! It appears when you try to add or edit a Persistent Trending group and 
have not specified a name for it

Failed to add DOC to ROT It appears when Persistent Trending cannot register with ROT (Running 
Object Table) upon initialization.  If this error occurs, you are advised to 
exit Persistent Trending and reboot the PC

Failed to remove DOC from ROT It appears when Persistent Trending cannot unregister from ROT 
(Running Object Table) upon exiting.  If this error occurs, you are 
advised to exit Persistent Trending and reboot the PC

Error opening Tag Browser It appears when the Persistent Trending cannot load the Endress+Hauser 
Tag Browser. Make sure that the Tag Browser has been properly installed 
and registered

Error Opening About Box It appears when the Persistent Trending cannot display the About box 
information. Make sure that the Endress+HauserAbout.dll has been 
properly installed and registered

Logging time interval should be adjusted 

or the number of samples increased.  Data 

buffer can be refreshed prior to logging.

This appears when you configure a Persistent Trending group for logging 
to a text file, and the Log to Disk settings are such that the logging 
interval is larger than the amount of data (samples) the group has been 
configured to keep in memory buffers. As a result, you can lose data 
while logging

Insufficient Security Level! It appears when you attempt to perform an operation within the 
Persistent Trending without having the required security attributes in the 
P View Security Server.

The selected language translation is not 

available

It appears when you try to switch languages and the Persistent Trending 
cannot find required the language resource DLL

A search string must be specified It appears when you try to perform point replacement operations without 
specifying a search string

A replace string must be specified It appears when you try to perform point replacement operations without 
specifying a replace string

OLE initialization failed.  Make sure that 

the OLE libraries are the correct version

It appears upon startup if the system OLE libraries have not been 
properly installed or are not up to date
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9.5.3 P View Trend Container

9.5.4 P View Trend Reporting

Message Meaning

Error Opening About Box It appears when the P View Trend Container cannot display the 

About box information. Make sure that the 

Endress+HauserAbout.dll has been properly installed and 

registered

OLE initialization failed.  Make sure that 

the OLE libraries are the correct version.

It appears upon startup if the system OLE libraries have not been 
properly installed or are not up to date.

Insufficient Security Level! It appears when you attempt to perform an operation within the P View 
Trend Container without having the required security attributes in the P 
View Security Server.

The selected language translation is not 

available. 
It appears when you try to switch languages and the P View Trend 
Container does not find the required language resource DLL .

Failed to create object.  Make sure the 

object has been entered into the system 

registry.

 It appears when you try to insert an ActiveX Control which cannot be 
found or has not been properly registered in the system registry. It is 
suggested that you re-install the specific control.

Could not save display list It appears when you try to save a display file list for automatic loading by 
P View Trend Container. Make sure that the target directory exists.

Could not load display list It appears when you try to load a display file list for automatic loading by 
P View Trend Container. Make sure that the target directory exists.

A Window with a titlebar must have a 

border

It appears when you configure a display or main application window 
style with conflicting options.

This is NOT a Pocket P View Trend File. 

Please Exit CE Configuration Mode First. 

It appears when the P View Trend Container has been set in CE 
Configuration mode and you try to load a non-CE display file.

Cut to clipboard failed. It appears when the P View Trend Container fails to execute a Cut menu 
action on an ActiveX Control. 

Copy to clipboard failed. It appears when the P View Trend Container fails to execute a Copy 
menu action on an ActiveX Control. Retry the operation

Failed to paste object from clipboard. It appears when the P View Trend Container fails to execute a Paste 
menu action from the Windows Clipboard. Retry the operation choosing 
Paste Special.

Item on the clipboard has zero size It appears when the available item on the Windows Clipboard has zero 
size. Retry placing the item on the Clipboard again.

Message Meaning

Error Opening About Box It appears when the P View Trend Reporting cannot display the 

About box information. Make sure that the 

Endress+HauserAbout.dll has been properly installed and 

registered.

OLE initialization failed.  Make sure that 

the OLE libraries are the correct version. 
It appears upon startup if the system OLE libraries have not been 
properly installed or are not up to date.

Insufficient Security Level! It appears when you attempt to perform an operation within the P View 
Trend Reporting without having the required security attributes in the P 
View Security Server.

The selected language translation is not 

available. 

It appears when you try to switch languages and the P View Trend 
Reporting does not find the required language resource DLL.

Error opening Tag Browser It appears when the P View Trend Reporting cannot load the 
Endress+Hauser Tag Browser. Make sure that the Tag Browser has been 
properly installed and registered.

Failed to add DOC to ROT It appears when P View Trend Reporting cannot register with ROT 
(Running Object Table) upon initialization. If this error occurs, you are 
advised to exit P View Trend Reporting and reboot the PC.

Failed to remove DOC from ROT It appears when P View Trend Reporting cannot unregister from ROT 
(Running Object Table) upon exiting. If this error occurs, you  are 
advised to exit P View Trend Reporting and reboot the PC.
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Please do not select to retrieve qualities or 

limit the number or report tags.

It appears during the configuring or editing of a report, which returns the 
samples in a CSV-type of format. There are more than 55 configured tags 
for the report, and you select Retrieve Qualities, as well.  This would 
result in a report with more than 255 columns, an upper limit for 
reporting to Excel, etc. You should either reduce the number of 
configured tags or not select Sample Quality Retrieval for the report.

No Report Name Assigned It appears during the configuring or editing of a report, to which no 
Report Name has been assigned. You should enter a Report Name.

No Tags Selected in Report It appears during the configuring or editing of a report, for which no tags 
have been selected. You should select tags for the report.

No Source Database Selected It appears during the configuring or editing of a report, for which no 
source database connection has been established. You should establish a 
source database connection for the report.

No Target Database Selected It appears during the configuring or editing of a report to a database and 
no target database connection has been established for the report. You 
should establish a target database connection for the report.

No Source Database Object Selected It appears during the configuring or editing of a report, for which no 
source database group has been selected. You should establish a source 
database group for the report.

No Source Group Object Selected  It appears during the configuring or editing of a report, for which no 
source logging group has been selected. You should establish a source 
logging group for the report.

No Condition Selected It appears during the configuring or editing of a report that executes on a 
condition, but no condition has been specified. You should configure a 
condition for the report.

Database query failed It appears during the configuring or editing of a report's database group 
object, logging group, or tags. P View Trend Reporting was unable to get 
the information from the underlying historical database.  Make sure that 
the database has not been moved or not been opened in Exclusive mode. 
If it is a remote database, make sure security has been properly 
configured and rights to reading info from the database have been 
enabled.  In addition, make sure that none of the historical database info 
tables has been deleted. You may want to reload the configuration to the 
datalogger again, and then attempt to configure the report.

Database Connection Failed It appears during the configuring or editing of a report's database group 
object, logging group, or tags. P View Trend Reporting was unable the 
get the information from the underlying historical database.  Make sure 
that the database has not been moved or not been opened in Exclusive 
mode. If it is a remote database, make sure security has been properly 
configured and rights to reading info from the database have been 
enabled.  In addition, make sure that none of the historical database info 
tables has been deleted. You may want to reload the configuration to the 
datalogger again and then attempt to configure the report.

No Table Entries Found! It appears during the configuring or editing of a report's database group 
object, logging group or tags. P View Trend Reporting did not find any 
records on the associated tables. You must either correctly configure data 
logging and download the configuration to the P View Trend SQL Logger 
or try to download the configuration to the datalogger again and then 
attempt to configure the report.

This database type is NOT Supported! It appears during the configuring or editing of a report's source or target 
database connections and the underlying database type is not supported. 
P View Trend for version 6.0, supports ONLY MS Access, MS SQL 
Server, MSDE and Oracle.

Please Enter a Valid Row Number (1 to 

25000) 

It appears during the configuring of a report to MS EXCEL and you select 
a starting Row for the report outside the limits supported by MS EXCEL.

Please Enter a Valid Column Number (1 to 

255) 
It appears during the configuring of a report to MS EXCEL, and you 
select a starting Column for the report outside the limits supported by 
MS EXCEL.

Maximum Number of Configured Reports 

has been Reached! 
It appears when P View Trend Reporting reaches its maximum number 
of configured reports.

Report Cannot be Disabled.  Try Canceling 

the Report.

It appears when you try to disable a report in Runtime mode while the 
report is executing. You should first cancel the report and then disable it.

Please Select a Valid Report Time Span It appears when you configure a report with an invalid time range span. 
You should adjust this selection.

Please make a valid time range selection.  

Report End Time is earlier than Report 

Start Time. 

It appears when you configure a report to execute within a starting time 
and an ending time and the report end time is newer than the report start 
time.
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No Target Text File is Selected It appears when you configure a text type of a report to execute and no 
valid target filename has been specified.

No Valid Excel Worksheet is Selected It appears when you configure an EXCEL-type of a report to execute and 
no valid EXCEL Worksheet name has been specified. In addition to the 
above user interface error messages, P View Trend Reporting sends the 
following messages and errors to the Gen Registrar (and if desired to the 
NT Event Logger).

Started Reports (Severity 500) When entering Runtime mode.

Stopped Reports (Severity 500) When exiting Runtime mode.

Error in Starting Reports (Severity 800) P View Trend Reporting could not enter Runtime mode.  Make sure that 
the computer is not running out of memory or resources or running 
some extremely CPU-intensive application.

Report was deleted (Severity 650) A report was deleted while P View Trend Reporting was in Runtime 
mode.

Report was Cancelled (Severity 650) A report was cancelled while P View Trend Reporting was in Runtime 
mode.

Report was deleted (Severity 650) A report was deleted while P View Trend Reporting was in Runtime 
mode.

No Errors Found (Severity 500) The report was executed with no errors.

Invalid Table Name (Severity 650) The report failed to execute because P View Trend Reporting could not 
get the information from the underlying historical database.  Make sure 
that the database has not been opened in Exclusive mode or moved. If it 
is a remote database, make sure that security has been properly 
configured and rights to reading info from the database have been 
enabled. Also make sure that no historical database info tables have been 
deleted. You may want to reload the configuration to the datalogger 
again and then attempt to configure the report.

No Data Found (Severity 650) The report failed to execute because P View Trend Reporting could find 
no historical data tables in the source database. 

Target Connection Failed (Severity 650) The report failed to execute because P View Trend Reporting could 
establish no database connection to the target database.  Make sure that 
the target database connections has been properly configured and not 
deleted, and all passwords and user id accounts have not been modified 
since the configuration of the report.

Failed to Create Target Table (Severity 

650) 
The report failed to execute because P View Trend Reporting could not 
create the target table either in the source or the target database. P View 
Trend Reporting will try to create a target table in the source database 
even if the report is configured as a CSV or MS EXCEL report type to 
accelerate the report creation.  Make sure that the source and target 
database connections have been properly configured and not deleted; the 
hard disk where the database is located has enough disk space; and the 
report target name does not include characters such as *, ^ etc. Also 
make sure that the tags configured in the report do not have characters 
such as *,%, etc. in their names. You may have to edit the Logging 
Names in the P View Trend configurator for the tags being logged.

Failed to Open Source Connection 

(Severity 650)

The report failed to execute because P View Trend Reporting could not 
establish a source database connection.  Make sure that the source and/
or target database connections have been properly configured and not 
deleted, and all passwords and user id accounts have not been modified 
since the configuration of the report.

Failed to Create ADO Objects (Severity 

650) 
The report failed to execute because P View Trend Reporting could not 
create ADO (ActiveX Data Objects) required to execute the reports.  
Make sure that ADO has been properly installed. Try re-installing ADO 
from the Endress+Hauser CD. 

Error in Updating Target Table (Severity 

650)

The report failed to execute because P View Trend Reporting could not 
update the target table either in the source or the target database. P View 
Trend Reporting will try to create a target table in the source database 
even if the report has been configured as a CSV or a MS EXCEL report 
type to accelerate the report creation.  Make sure that the source and 
target database connections have been properly configured and not 
deleted; the hard disk where the database is located has enough disk 
space; and the report target name does not include characters such as *, 
^, etc. In addition, make sure that the tags configured in the report do 
not have characters such as *,%, etc. in their names. You may have to 
edit the Logging Names in the P View Trend Configurator for the tags 
being logged.
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9.5.5 TWXTray

Error in Opening Target Table  (Severity 

650) 
The report failed to execute because P View Trend Reporting could not 
read (open) the target table either in the source or the target database. P 
View Trend Reporting will try to create a target table in the source 
database even if the report is configured as a CSV or a MS EXCEL report 
type to accelerate the report creation.  Make sure that the source and 
target database connections have been properly configured and not 
deleted; the hard disk where the database is located has enough disk 
space; and all passwords and user id accounts have not been modified 
since the configuration of the report.

Failed to Load EXCEL  (Severity 650) The report failed to execute because P View Trend Reporting could not 
load EXCEL.  Make sure that MS EXCEL has been properly installed on 
the same PC where P View Trend Reporting is installed and that the 
desired MS EXCEL workbook has not been opened exclusively or 
deleted

Error in Printing EXCEL Worksheet  

(Severity 650)

The report failed to print automatically the target MS EXCEL Worksheet.  
Make sure there a printer has been installed and configured properly.

Error in Disconnecting From EXCEL 

(Severity 650) 
P View Trend Reporting failed to disconnect from MS EXCEL.  The user 
may have to shutdown MS EXCEL manually.

Message Meaning

TWX SQL Data Logger failed loading its 

latest configuration. 

This error occurs when TWX SQL Data Logger cannot load its last 

configuration. The likeliest cause of this error is that no TWX 

SQL Data Logger configuration exists. Use P View Trend 

Configurator to create and save Logger configuration.

Unable to start an instance of TWX SQL 

Data Logger. 

COM error occurred when creating TWX SQL Data Logger object. Make 
sure that TWX SQL Data Logger application has been properly installed 
and registered.

Can not start TWXReporter. This message indicates an error has occurred during an attempt to start P 
View Trend Reporting. Make sure that P View Trend Reporting 
application has been properly installed and registered

'EnterRuntime' method of TWX Reporter 

failed. 

This message indicates an error has occurred during an attempt to call P 
View Trend Reporting's EnterRuntime method. Make sure that P View 
Trend Reporting application has been properly installed and registered.

'Open' method of TWX Reporter failed. This message indicates an error has occurred during an attempt to call P 
View Trend Reporting's Open method. Make sure that P View Trend 
Reporting application has been properly installed and registered.

'StopReports' method of TWX Reporter 

failed. 

This message indicates an error has occurred during an attempt to call P 
View Trend Reporting's StopReports method. Make sure that P View 
Trend Reporting application has been properly installed and registered.

'Open' method of Persistent Trending 

object failed. 
This message indicates that an error has occurred during an attempt to 
call Persistent Trending's Open method. Make sure that Persistent 
Trending application has been properly installed and registered.

'EnterRuntime' method of Persistent 

Trending object failed. 
This message indicates an error has occurred during an attempt  to call 
EnterRuntime method of Persistent Trending. Make sure that Persistent 
Trending application has been properly installed and registered.

'ExitRuntime' method of Persistent 

Trending object failed. 
This message indicates that an error happens during an attempt to call 
"ExitRuntime" method of Persistent Trending. Make sure that Persistent 
Trending application is properly installed and registered.
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9.5.6 P View Trend SQL Data Logger

Message Meaning

Error Opening About Box It appears when the Data Logger cannot display the About box 

Information. Make sure that the Endress+HauserAbout.dll has 

been properly installed and registered.

Insufficient Security Level! It appears when the user attempts to perform an operation within the 
Data Logger without having the required security attributes in the P 
View Security Server.

The selected language translation is not 

available. 

It appears when the user tries to switch languages and the Data Logger 
has not found the required language resource DLL.

OLE initialization failed.  Make sure that 

the OLE libraries are the correct version.

It appears upon startup if the system OLE libraries have not been 
properly installed or are not up to date.

Cannot change files while OPC Clients are 

connected to this server. 

It appears when the user tries to shutdown the Data Logger and there are 
DCOM/COM clients connected to it (including Trend ActiveX's, P View 
Trend Configurator, and VB Scripting clients). You should shutdown all 
client applications first.

Cannot change files while OPC Clients are 

connected to this server. 
It appears when the user tries to open a new *.txd configuration file on 
the Data Logger and there are DCOM/COM clients connected to it 
(including Trend ActiveX's, P View Trend Configurator, and VB Scripting 
clients ). You should shutdown all client applications first.

Not A Valid Configuration Name It appears when you try to export an existing 5.20 *.txd configuration 
file to the new P View Trend Configuration database using an invalid 
configuration name.

Failed to Connect to Database It appears when you try to export an existing 5.20 *.txd configuration 
file to the new P View Trend Configuration database and the Data Logger 
fails to connect to the database.  Make sure that the configuration 
database exists and is not opened in Exclusive mode.

An error log was generated. Do you want 

to save it? 
It appears when you try to export an existing 5.20 *.txd configuration 
file to the new P View Trend Configuration database and errors occur 
while exporting the configuration. In addition to the above user interface 
error messages, the Data Logger sends the following messages and errors 
to the Gen Registrar (and, if desired, to the NT Event Logger)Started 

Logging (Severity 500) - When entering Runtime mode.Stopped 

Logging (Severity 500) - When exiting Runtime mode.

Failed to create threads - runtime aborted 

(Severity 800)

The Data Logger could not enter Runtime mode.  Make sure that the 
computer is not running out of memory or resources, or running some 
extremely CPU-intensive application.

Database Group DeActivated (Severity 

600)

A database group has been deactivated, and logging for it is not active.

Activated Database Group (Severity 600) A database group has been activated, and logging for it is now active.

Logging Group De-Activated (Severity 600) A logging group has been deactivated, and logging for it is not active.

Activated Logging Group (Severity 600) A logging group has been activated, and logging for it is now active.

Switched Logging Database Connection 

(Severity 650) 
The database group have switched database connections in response to 
an external command.

Conflicts In Table Naming - aborted 

runtime  (Severity 800) 
The Datalogger has aborted Runtime due to conflicts in table-naming and 
overall data logging configuration.  On starting Runtime mode or 
uploading a configuration file, the Data Logger tries to perform a database 
consistency and conflict resolution test. You should make sure the table 
names selected for data logging include no improper characters such as 
^,*, etc.; that the target historical database has not been deleted; has 
been properly configured; and the security attributes of the database 
allow the Data Logger application to read, create, and alter database 
tables without any restrictions.

Errors Found in Activating Database 

Logging Group (Severity 750) 
The Data Logger could not activate the desired Database Group.  You 
should make sure that table names selected for data logging do not 
include improper characters such as ^,*, etc.; that the target historical 
database has not been deleted and has been properly configured; and the 
security attributes of the database allow the Data Logger application to 
read, create and alter database tables without any restrictions.

Errors in De-Activating (Severity 750) The Data Logger could not activate the desired Database or Logging 
Group.  The Database or Logging Group has already been deactivated. 

Database Switching Failed!  (Severity 750) The Data Logger failed to switch database connections for a database 
group.  Make sure the new database has been properly configured and 
the Data Logger application has the proper security settings to create, 
open and modify tables.  Also make sure that enough GENENSIS-32 
client units are available to switch to a high-end-supported database.
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Missing Logging Tags  (Severity 650) The Data Logger failed to request a configured tag from the 
corresponding OPC server.  Make sure that the tag has been configured 
in the OPC server database.

Error in Connecting to Database  (Severity 

750) 
The Data Logger lost database connection while data logging.  Make sure 
the database is available; the network connection is active; and a user or 
administrator has not opened the database in Exclusive mode.

Established Connection to Database 

(Severity 500) 
The Data Logger has restored connection to the logging database.

Maximum Number of Packets Reached - 

Possible Data Loss (Severity 650) 
The Data Logger has reached the maximum number of data logging 
packets to hold in memory (on a per-logging-group basis); as a result, 
data loss may occur.  Make sure the PC is not overloaded; the database is 
available; the network connection is active; and a user or administrator 
has not opened the database in Exclusive mode. The configuration of 
data logging may have to be evaluated to prevent the system from 
overloading. You may also have to modify registry settings for the 
maximum number of packets.

Lost Data Packet (Severity 750) The Data Logger has had to discard a logging packet because either the 
maximum number of data logging packets to hold in memory has been 
reached or the maximum number of retrials for data logging a packet of 
data has been exceeded.  Make sure the PC is not overloaded; the 
database is available; the network connection is active; and a user or 
administrator has not opened the database in Exclusive mode. The 
configuration of data logging may have to be evaluated to prevent the 
system from overloading. You may also have to modify registry settings 
for the maximum number of packets or data-logging retrials.

Retried To Log Data (Severity 650) - The 
Data Logger has had to retry to log a logging 
packet. 

 Make sure the PC is not overloaded; the database is available; the 
network connection is active; and a user or administrator has not opened 
the database in Exclusive mode. The configuration of data logging may 
have to be evaluated to prevent the system from overloading. You may 
also have to modify registry settings for the maximum number of packets 
and/or data-logging retrials.
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9.6 P View Script and SwxEngine

9.6.1 Run Script

Message Meaning

Scripting engine did not start yet, do you 

want to wait? 

Script engine has not started in the expected time. The computer 

can be overloaded, so wait for a while.

Failed to start scripting engine. The 

application cannot fully operate! 
Check that the scripting engine SwxEngine.exe is available and has been 
registered. Try to re-install the application.

Application failed to register properly at 

GenRegistrar server and will terminate 

now. 

Check that the GenRegistrar component has been installed. Try to re-
install the application.

Error Initializing VBA Failed to properly initialize VBA component. Try to re-install the 
application.

Cannot start Subscription Editor. Check that the component has been installed. Try to re-install the 
application.

Scripting engine disconnected. It is 

recommended to restart the P View Script.  

Press OK to exit now, press Cancel to 

continue. Scripting engine has unexpectedly 
been terminated. Restart the application.

Configuration of console events failed 

when calling the scripting engine. 

Failed to configure the scripting engine. Try to restart the application. 
Check if there is only one instance of SwxEngine in the Task Manager.

Configuration of system events failed 

when calling the scripting engine. 
Failed to configure the scripting engine. Try to restart the application. 
Check if there is only one instance of SwxEngine in the Task Manager.

Setting of current directory failed when 

calling the scripting engine.

Failed to configure the scripting engine. Try to restart the application. 
Check if there is only one instance of SwxEngine in the Task Manager.

Another instance of P View Script is 

already running

 The P View Script configurator and monitor (P View Script.exe) can run 
only in one instance. An attempt to run a second instance has been 
detected. 

Message Meaning

No available idle thread to run the script 

or the script failed

Either increase the number of script engine available threads in P 

View Script Tools | Set Number of Threads or configure the 

application to run fewer scripts in a given period of time, or 

optimize the scripts to run faster. Check if some scripts do not 

hang up in the scripting engine (i.e., in never-ending loops, etc.).

Script <ScriptName> failed to run because 

of no idle thread was found

 Either increase the number of script engine available threads in P View 
Script Tools | Set Number of Threads or configure the application to run 
fewer scripts in a given period of time or optimize the scripts to run 
faster. Check if some scripts do not hang up in the scripting engine (i.e., 
in never-ending loops, etc.).

Scripting engine failed to start a script 

<ScriptName>

 Check if there is the scripting engine in the Task Manager and if the 
application is in Runtime mode. Check if the DLL containing the script 
has been made from the related *.vba project and has been correctly 
registered. Check if the project, module, and script name match the 
related VBA project, VBA module, and procedure. Note: The script can 
be started only from the Designer module (named "Main" by default).

Scripting engine failed to suspend a script 

<ScriptID>

 The script could already be finished; therefore, it has not been possible 
to suspend it.

Swx32 SuspendScript: Script is not found 

in the scripting engine. It could already 

finish

 The script could already be finished; therefore, it has not been possible 
to suspend it.

Scripting engine failed to resume a script 

<ScriptID>

 The script could already be killed; therefore, it has not been possible to 
suspend it.

Swx32 StartScript(): Call method 

StartRuntime prior to StartScript. 

Application is not in Runtime mode. Use StartRuntime method to put it 
into Runtime.

Scripting engine failed to terminate a 

script <ScriptID>. 

The script could already be finished; therefore, it has not been possible to 
suspend it.

Not all scripts exited yet. Press OK to 

terminate them, press Cancel to wait for a 

while.

Some scripts can take longer to finish. Wait for a while to let them finish. 
Check to see that they do not contain deadlocks or never-ending loops.
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9.6.2 Synchronization of File and VBA Editor 

9.6.3 Script Wizard

Message Meaning

The related VbaMT project (*.vba) was 

not found. Please open the VBA editor and 

locate the project manually using File > 

Open Project.... 

Open the VBA editor and use menu File > Open to load the 

project manually.

Failed to open VBA project: 

<ProjectName> Check the project exists 

and load it manually in VBA editor. 

Open the VBA editor and use menu File > Open to load the project 
manually.

Failed to compile VBA project. Check if 

the VBA Project name matches the current 

Project name. 

You can open VBA editor and make the DLL manually using menu item 
File > Make <Project>.DLL... - There has to be a VBA project and 
module opened in the VBA editor, whose names must match the names 
"Project" and "Module" in a script trigger configuration to compile from 
the configuration screen. Note: It is possible to compile manually a VBA 
project and module in VBA editor, assuming the project and module 
names have been typed in the related fields in the script trigger 
configuration screen.

Failed to add a script code. Check if there 

is the related project matching current file 

name loaded and if it contains designer 

module Main. 

Open the VBA editor and use menu File > Open to load the related 
project manually.

Failed to jump to a specified script 

procedure. Check if the procedure exists 

in specified module. 

Open the VBA editor and use menu File > Open to load a project 
containing the procedure manually.

Procedure <ScriptName> not found in 

current project or the scripting engine not 

ready.

Make sure the scripting engine is ready and the VBA contains the related 
project and procedure. Use menu File > Open to load the project 
manually.

Message Meaning

Script wizard failed to insert a script 

procedure into current project or the 

scripting engine not ready. 

Check if the current project exists in the VBA editor. Create it 

manually if necessary. Open the VBA editor and use menu File > 

Open to load the project manually.

Script wizard template files not found in 

the <DirectoryName> directory. The 

Script Wizard exits now. 

Check if the script wizard directory has been presented in the installation 
directory and if it contains the subdirectories with *.stp (script template) 
files. Script template *.stp files are regular ASCII files. It is possible to 
check them, for example, in Notepad.

Script wizard provided no code for the 

script body. Check the script template 

files. 

There was no VBA code found in the script template file. Check the 
script template *.stp file in the related ScriptWizard directory. Script 
template *.stp is an ASCII file. It is possible to check it, for example, in 
Notepad.

Script wizard template script does not 

contain required keyword # : which 

separates the header from the script. 

The script template does not contain the expected keyword, which 
closes the Header section. Check if the script template has not been 
damaged. Script template *.stp is an ASCII file. It is possible to check it, 
for example, in Notepad.

Failed to compile current project into 

VbaMT DLL.

The VBA project could not be compiled into VBA DLL, and the scripts 
inside this project will not run. The reason could be either a missing VBA 
project (create/open the correct one in VBA Editor using either menu 
File > New or File > Open) or there is a syntax error in the compiled 
scripts (open VBA Editor and try the menu Debug > Compile <Project>. 
This usually provides you with a good idea of what the problem is. Then 
try to compile the project manually using the menu File > Make 
<Project>.
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9.6.4 Security

Message Meaning

Insufficient security level. Log as a client 

with the necessary security rights. 

The current user is not allowed to do the intended action. Log in 

as a user with the proper security rights. Refer to Security 

documentation.

Insufficient security level to start 

application. Log as a client with the 

necessary security rights.  

The current user is not allowed to do the intended action. Log in as a 
user with the proper security rights. Refer to Security documentation.

Insufficient security level to exit 

application. Log as a client with the 

necessary security rights.  

The current user is not allowed to do the intended action. Log in as a 
user with the proper security rights. Refer to Security documentation.

Insufficient security level. Log-in as a user 

with the proper security rights. 

The current user is not allowed to do the intended action. Log in as a 
user with the proper security rights. Refer to Security documentation.

Insufficient security level to configure the 

scripting engine. Log-in as a user with the 

proper security rights. 

The current user is not allowed to do the intended action. Log in as a 
user with the proper security rights. Refer to Security documentation.

Unable to run the security login client. 

Make sure the file Login.EXE exists in the 

same directory as this application. 

The Login.exe has failed to start. Check if the security is installed 

on the current computer and if the Login.exe is in the P View 

Script installation directory.

Unable to launch the security 

configuration application. Make sure the 

file Security.EXE exists in the same 

directory as this application.

The Security.exe has failed to start. Check if the security is installed on 
the current computer and if the Security.exe is in the P View Script 
installation directory.

Script <ScriptName> failed to run because 

of security.

The current user is not allowed to do the intended action. Log in as a 
user with the proper security rights. Refer to Security documentation.
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9.7 P View Alarm

9.7.1 P View Alarm Server

Internal errors encountered by the P View Alarm Sever are reported via the Endress+Hauser Event 

Server, another OPC Alarm & Events compliant server. The Endress+Hauser Event Server can 

optionally write selected events to the NT Event Log. The following simple events can be generated 

by the P View Alarm Server

For the Endress+Hauser Event Server, severity values of 600 and below are considered "normal." 

Severity values of 601 to 1000 are considered errors.

9.7.2 P View Alarm Logger

Any error conditions encountered by the logger will be reported via the Endress+Hauser Event 

Server and optionally to the Windows NT Event Log. To allow the logger to send messages to the 

NT Event Log, select Start > Programs > Endress+Hauser > P View > License Monitor. Select 

the Events tab. Check AWXLog32 in the list of applications.

Here are the possible messages:

Severity Message

500 "%1 %2 Started."

500 "%1 %2 Stopped."

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Unknown"

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Tag does not exist."

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Rejected by Security Server."

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Licensed I/O Point Count 
Exceeded. "

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Demo mode has timed out."

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: Local I/O not allowed on Browser 
node."

700 "Alarm Tag: %1, Condition: %2, Input Item: %3, Error: COM error registering with 
GenRegistrar."

800 "%1 %2 Failed to Register with GenRegistrar. Reason: %3"

800 "No configuration found for node and no ""Default"" configuration in Database Provider: 
%1 Connection:  %2"

800 "Database Error - Provider: %1 Connection: %2"

Severity Source Message

500 AWXLog32 Endress+Hauser P View Alarm Logger Started.

500 AWXLog32 Endress+Hauser P View Alarm Logger Stopped.

500 AWXLog32 Primary Printer "%1" now in service. Printing on Backup Printer "%2" terminated.

500 AWXLog32 Printing has resumed.

500 AWXLog32 Configuration "%1" INSERT INTO table "%2" succeeded.

750 AWXLog32 Failed to Open Primary Printer "%1"

750 AWXLog32 Configuration "%1" printer event queue overflow. Messages have been lost. 
Queue size is %2 events.

750 AWXLog32 Primary Printer "%1" has failed. Now Printing on Backup Printer "%2."

750 AWXLog32 Configuration "%1" filter is inactive due to syntax error(s).

750 AWXLog32 Configuration "%1" logging event queue overflow. Messages have been lost. 
Queue size is %2 events.

800 AWXLog32 (Error string from database is in "Comment" Attribute.)

Provider %1

Connection %2

(Error string from database is in "Comment" Attribute.)
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800 AWXLog32 Error Querying Configuration Database:
Provider %1

Connection %2

Query %3
(COM error string is in "Comment" Attribute.)

800 AWXLog32 Configuration Database has no configuration for "Node" and no "Default."
Provider %1

Connection %2

800 AWXLog32 Error opening Logging Database for Configuration "%1"
Provider %2

Connection %3

(COM error string is in "Comment" Attribute.)

800 AWXLog32 Query of Column definitions failed for configuration "%1"
Query %2
(COM error string is in "Comment" Attribute.)

800 AWXLog32 Error opening Configuration Database:
Provider %2

Connection %3

(COM error string is in "Comment" Attribute.)

800 AWXLog32 Configuration Database has no configuration "%1".
Provider %2

Connection %3

(COM error string is in "Comment" Attribute.)

800 AWXLog32 Configuration "%1" subscription to OPC Event Server(s) failed.

800 AWXLog32 Configuration "%1" error assigning value to column "%2"

800 AWXLog32 Configuration "%1" INSERT INTO table "%2" failed. 
(Error string from database is in "Comment" Attribute.)

800 AWXLog32 Failed to register "%1" with GenRegistrar. Configuration "%2" will not execute.

800 AWXLog32 Printing to both Primary Printer "%1" and Backup Printer "%2" has failed.

Severity Source Message
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9.7.3 P View Alarm Report

Message Meaning

Database Type not supported Error occurs when ConnectionString property is set to the string specifying 

OLE DB connection to a database other than MS ACCESS or MS SQL 

Server.

Crystal Reports Database 

Connection was not configured. 

Would you like to select ODBC 

connection now?

This message box pops up during an attempt to launch Crystal Reports (either by 
clicking Report button on AWXRep32 toolbar or calling LaunchReport method) 
when Crystal Reports have not previously been configured.  By selecting Yes 
button, you could open the ODBC panel and select the appropriate ODBC 
connection for Crystal Reports configuration.

Crystal Report failed during 

connection to database. 

Indicates that incorrect ODBC connection was specified for Crystal Reports. 
Change connection and try again.

Crystal report - SQL Server 

Error. 
This error indicates that Crystal Reports could not recognize the data structure in 
the given table. It occurs when some columns are renamed or deleted.

Printer error occurred. This error message appears if incorrect printer response was received during alarm 
data printing. Fix printer problem and try again.

Can't load toolbar. This message box appears when loading toolbar resource fails due to lack of GDI 
resources. Restart container application and/or close other applications that use 
many GDI resources.

Error at toolbar creation. This message box indicates that attempt to create toolbar failed due to lack of GDI 
resources. Restart container application and/or close other applications that use 
many GDI resources.
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9.7.4 P View Alarm Viewer

Message Meaning

The selected language translation is not 

available

 The language translation file is not available.  Possible reasons 

are either an incorrect language name or the file is not in the bin 

directory.

The selected language resource is too old.  

Please obtain an updated version of the 

file. 

The language file version is incorrect.  A new language file must be 
created with the current resource files.

Unable to Open File  The system could not open the file.  A corrupted file or an unsupported 
version could be the cause.

Unknown Version.  Using Default Settings  The system did not recognize the alarm viewer information stored in the 
document.  A corrupted file or an unsupported version could be the 
cause.
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9.8 Data Collector

Error messages that appear 

in the message boxes:

Error messages that may 

appear in the output 

window:

Message Meaning

OLE initialization failed.  Make sure that 

the OLE libraries are the correct version. 

DWX cannot run because of problems with OLE. The user should 

check OLE DLLs.

The selected language translation is not 

available. 

You tried to select another language, but the translation DLL cannot be 
found. Contact your local vendor to get the proper translation DLL.

The selected language resource is too old. Please obtain an updated version of the file: - You attempted to select 
another language, but the available translation DLL is outdated.

At least two nodes must be defined. Two nodes must be defined for redundancy--a primary node and at least 
one backup node.

Specified common name is not unique. The name specified as "Common Name For Redundancy" must be 
unique within all DWX registers. Choose another name.

Specified name of node status register is 

not unique. 

The specified name of the node status register must be unique within all 
DWX registers.

Automatic runtime start was not allowed 

by the security server. 

DWX is set up to go into Runtime when started by an OPC client, but the 
system security has denied it. See the security administrator to allow this 
action.

Data Collector cannot referenc e itself via OPC. Referencing OPC items itself is not allowed. DWX can 
work only with other OPC servers. Tip: Try to delete the 
Endress+Hauser.Data Collector string to get what you want.

Data Collector can only reference its 

aliases at this place. 
DWX can only reference itself when the point name contains aliases.

Error writing point: <point name> DWX cannot write into the given point. Check security related to that 
point and the OPC server configuration. The point might be read-only.

Can't read header data from file 

<filename> 

The specified CSV file does not have a header.

File <filename> has invalid structure. The specified CSV file does not have a valid format. Check for missing 
double-quotes, and the proper number of commas in every line, etc.

Can't convert value(s) from file 

<filename>. 
The given CSV file contains a value that cannot be converted to the 
required data type.

Can't export CSV file: <filename> DWX cannot write to specified file.

Can't import CSV file: <filename> DWX cannot read specified file.

P View Registration Server denied running 

Data Collector. 

DWX cannot run because there are no client units left. Close 

some other P View application to run DWX.

Another instance of Data Collector is 

already running. 
Only one instance of DWX can run on a computer at a time. Close the 
other one first.

Specify name of the OPC item. Specify the OPC item name in the form: [\\<node name>\]<server 
name>\<item name>.

Error opening About Box. DWX cannot find About box.

Unable to run the security login client. DWX cannot find the security login application. Make sure P View has 
been properly installed.

Unable to launch the security 

configuration application. Make sure the 

file Security.EXE exists in the same 

directory as this application. 

DWX cannot find the security configuration application. Make sure P 
View has been properly installed.

Message Meaning

<item name>: Add item FAILED  DWX cannot access the specified OPC item because AddItems 

operation has failed. The specified point probably does not exist 

in the server. Check the point name and the OPC server 

configuration.

<item name>: Demo over. DWX cannot access the specified OPC item because the Demo mode is 
over. DWX must be restarted to work in the Demo mode again.

<item name>: Point count exceeded. DWX cannot access the specified OPC item because the total number of 
accessed points have exceeded the limit given by the license. Close some 
other P View application.

<item name>: Error: Local point not 

allowed. 
The current license does not allow accessing points locally.

<item name>: Error: P View Registrar not 

found.

DWX cannot locate the P View Registrar to get the license information.

<item name>: Generic ERROR. A generic OPC error occurred when DWX tried to access the specified 
OPC item.
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9.9 License Utility

License utility errors are generated while running the License Utility. These errors appear on a dialog 

box and are of the following format:

• License Utility Error (CKERR - #):

• (error details)

Refer to License Utility Help for more information.

9.9.1 Initialization Errors 

9.9.2 Authorization Errors 

Message Meaning

Initialization of Key Protection Failed General failure message,  which is further described by a second 

message. This error can occur if files related to the License utility 

have been moved or deleted. If the operating system is Windows 

NT, make sure CRYPSERVICE service is running. If the problem 

persists, restart your computer and re-install the Licensing 

Utility.

Unable to Find Program File. The Licensed Program file could not be found. This problem occurs only 

if the folder or files related to the licensing utility have been tampered 

with. Uninstall the licensing utility and re-install it.

Incorrect Master Key. The License Utility in use does not support this product. This problem 

occurs only if the folder or files related to the licensing utility have been 

tampered with. Uninstall the licensing utility and re-install it.

Master Key Does Not Match Program. The License Utility in use does not support this product. This problem 

occurs only if the folder or files related to the licensing utility have been 

tampered with. Uninstall the licensing utility and re-install it.

Unable to Create License Files. Disk error has occurred. This can also be due to insufficient disk space. 

Make sure you have at least 1 MB of free disk space for the licensing 

utility.

Message Meaning

A valid license already exists.  The License 

must be Killed before enabling Backup 

Authorization. 

The Backup Authorization allows a user to authorize a second 

temporary license in case a failure occurs during a license 

upgrade.  If the license is already valid, there is no need to 

authorize another temporarily.

Failed to Authorize Software Key. A valid 

license does not exist. Get a valid software 

license.

Software Key Is NOT Initialized. A reference to the Site Key was not possible because prior initialization 

failed. Restart the Licensing Utility and try again.

Attempt to Run from Floppy. A PC is licensed using one of the hard drives.  The license cannot be 

issued to or exist on a floppy diskette.

Software Key has been moved  (or) 

password is incorrect.

The Site Key issued was created with an invalid password.  This error can 

also occur if the Site Key entered belonged to a prior Site Code that has 

subsequently changed.  For example, a Site Code was generated and 

returned to Endress+Hauser.  Meanwhile, a temporary Site Code had 

been installed before the original site key was installed. 

Master Key Does Not Match Program. The license may have been renamed.

The System Time has been set to a Date 

previous to Site Key.

Tampering with the date or time can invalidate a time-limited license.

The Restriction File has been Deleted. One of the license system files has been deleted. You may have to obtain 

a new license. Contact Endress+Hauser.

Restriction File has been Damaged. One of the license system files has been tampered with. You may have to 

obtain a new license. Contact Endress+Hauser.

Restriction File has been Moved or 

Overwritten. 

One of the license system files has been moved. You may have to obtain 

a new license. Contact Endress+Hauser.  This may be caused by 

reformatting drive C: on a single drive containing two partitions.

User has Attempted to use an old Site Key. Site Keys cannot be reused. You may have to obtain a new license. 

Contact Endress+Hauser.
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9.9.3 Transfer Errors 

9.9.4 License Removal Errors

Failed to Save Site Key!!! An error occurred while entering a new Site Key.  You may have to 

obtain a new license. Contact Endress+Hauser.

User Is trying to Reuse Old Key Site Keys cannot be reused.

Key Has Been Mis-typed. The entered Site Key is not valid.

The License File Could NOT be Written.  

Disk Full ??? 

Check to see if disk is full.

Failed to get site code. Reinstall the license utility

The entry file was unable to be opened. One of the license system files may have been moved. Move the files 

back to their original folders.

Unable to Get Key Restrictions. The license could not be read properly. This error may occur due to 

improper initialization. Exit the licensing utility and try again.

Message Meaning

Only Unauthorized Sites can be Used! A license cannot be transferred to an existing authorized PC.

Problem in Opening Registration File in 

specified directory.

The diskette file containing transfer information could not be opened 

from the supplied directory due to invalid directory, write protection, 

disk not ready or no disk space.  Check diskette and try again.

Target diskette already has authorization 

files.  Proceed to step 3.

The transfer diskette already contains registered files. Proceed to step 3.

Site Can have Only One outstanding 

registration at a time! 

Once a floppy has been registered, the license utility does not allow a 

second floppy to be initialized. To override this limitation, delete the  

GENLIC32.REG file from the \ProgramFiles\Endress+Hauser\Softlic 

directory and try again.

Could not Open matching Registration 

File. 

The matching registration file in the same directory as the program could 

not be opened.  Check transfer diskette and try again.

Could not Write Matching Registration 

File. 

The matching registration file in the same directory as the program could 

not be written to.  Check transfer diskette and try again.

License Transfer In error. General message, which is further detailed by a second message.

Transfer Is Allowed only for Unauthorized 

Software Key.

A license cannot be transferred to an existing authorized PC.

Could Not Find Registration File for 

Software Key.

Make sure the transfer diskette has been installed at specified path and 

try again.

Outdated Registration Files are used. The transfer diskette in use does not apply to current transfer.

Unable to find Site Key in Given directory. A valid Site Key was not found on transfer diskette.  You may have to 

obtain a new license.

The Site Key File has been damaged. A valid Site Key was not found on the transfer diskette. You may have to 

obtain a new license.

Unable to Find Registration file on Floppy. The transfer diskette was not registered properly in Step 1 of the transfer.

Transfer is attempted for different 

application.

The license being transferred from this PC is not of the same license type 

on destination PC.

Transfer Files are Already in Floppy. The transfer diskette already contains the license to be transferred.

Message Meaning

Invalid Password A password is needed to delete a Site Key.  Call Endress+Hauser.

Cannot create KILL.TXT File. Details of license removal could not be written to disk. Failed to Destroy 

the License.

Software Key Is NOT Initialized. Exit the license utility and try again.

The protected program is not authorized. Exit the license utility and try again.

The license files are currently write 

protected.

Exit the license utility and try again.
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9.9.5 Temporary Licensing Errors 

9.9.6 General Errors

Message Meaning

Temporary Authorization Period has expired The license utility attempted to create a 30-day license, but the one-

time-only license had already been used and has since expired. You 

cannot use the 30-day temporary authorization more than once.

Message Meaning

Could Not Get License Information. Exit the license utility and try again.

Failed to Initialize Software Key. If running NT, make sure CrypKey.INI file has accurate paths and reboot. 

Exit the license utility and try again.

Unable to Perform the Thunk Operation. Exit the license utility and try again.

Registry Query Error. Exit the license utility and try again.

Unable to close file. Check hard drive. Exit the license utility and try again.

Disk access error - Check hard drive. Exit the license utility and try again.

File could not be written. Check hard drive. Exit the license utility and try again.

File data item could not be written. Check hard drive. Exit the license utility and try again.

GlobalLock/GlobalUnlock failed An error occurred while accessing ClipBoard.  Another application is 

currently using ClipBoard. Exit the license utility and try again.

Error creating Registration Text File. Exit the license utility and try again.
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9.10 Security

9.10.1 Security Server

NT Application Event Log 

Messages

The following messages will appear in the Windows NT Event Log under normal operation. These 

messages are for the administration and are not error messages.

Message Box Errors

9.10.2 Login Client

Message Meaning

User %1 has logged in from station %2. This message appears when a user logs in from a node.

User %1 has logged out from station %2. This message appears when a user logs out from a node.

User %1 has been automatically logged out 

from station %2. 

This message appears when a user is automatically logged out from the 

system.

Endress+Hauser Security Server has 

started. 

This message appears when the Endress+Hauser Security Server starts.

Endress+Hauser Security Server has 

shutdown. 

This message appears when the Endress+Hauser Security Server shuts 

down.

User %1 has logged in for Administration. This message appears when a user logs in as the administrator.

User has logged out for Administration. This message appears when a user logs out as the administrator.

Software License not found.  Beginning %2 

hour demo. 

This message appears when a user starts P View and a valid license is not 

found. The system starts in the Demo mode.

Software License not found and demo 

period expired. ALL ACCESS DENIED. 

This message appears when P View runs in the Demo mode and shuts 

down after the Demo period.

Message Meaning

Error loading AppSec.DLL! The dll APPSEC.DLL must be in the same directory as the security server 

(SECURITY.EXE). This file could not be found or is corrupt. You must 

copy this file back or reinstall P View after uninstalling the current setup

Message Meaning

The Security Server is not installed on the 

local computer.

Install the Security Server, or select Preferences from the Options 

menu and choose the network node where the Security Server 

has been installed.

The Security Server is not installed or is 

not responding on network node %1.

This is usually caused by a network failure. To select a Security Server 

installed on a different machine, select Preferences from the Options 

menu and choose a working network node where the Security Server 

has been installed.

Endress+Hauser About Box Automation 

Server is not registered! 

The installation of P View failed to register the About Box Automation 

Server. Reinstall P View.
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10 Endress+Hauser License Agreement

YOU SHOULD CAREFULLY READ THE FOLLOWING 

TERMS AND 

CONDITIONS!

Opening and using the enclosed software for any purpose indicates your acceptance of the terms 

and conditions of this license agreement.  If you do not agree with them you should return all 

software, documentation and copy protection keys within seven days of shipment unopened and 

your money will be refunded.

Endress+Hauser provides this program and licenses its use in the United States, Puerto Rico, or 

internationally.  You assume the responsibility for the selection of the program to achieve your 

intended results, and for the installation, use and results obtained from this program.

LICENSE You are granted a personal license to use this program under the terms stated in this Agreement.  

You may: 1) Install and use the program on a single machine.  2) Make a single archival back-up 

copy of the program for the sole purpose of supporting your use of the single program on a single 

machine.  3) You may not use, copy, modify, or transfer the program, or transfer any copy, in whole 

or in part, except as expressly provided in this license, or with a written contractual agreement with 

Endress+Hauser, Inc.

TERM The license is effective until terminated.  It will terminate if you fail to comply with any term or 

condition of this Agreement.  You agree, upon such termination, to destroy the program and all 

copies that were made from it and to promptly return any copy protection key(s) to Endress+Hauser.

LIMITED WARRANTY Endress+Hauser WARRANTS THE DVD-ROM OR PHYSICAL DISKETTES, ON WHICH THE 

PROGRAM IS FURNISHED, AND PHYSICAL DOCUMENTATION TO BE FREE OF DEFECTS IN 

MATERIALS AND WORKMANSHIP UNDER NORMAL USE FOR A PERIOD OF NINETY (90) 

DAYS FROM THE DATE OF DELIVERY TO YOU AS EVIDENCED BY YOUR RECEIPT.  THIS 

PROGRAM IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED 

OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF TITLE, 

NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  THE 

ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU.  

SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF ALL 

NECESSARY SERVICING, REPAIR, OR CORRECTION.

Endress+Hauser SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES, EXPRESSED OR 

IMPLIED, INCLUDING BUT NOT LIMITED TO, IMPLIED WARRANTIES OF TITLE, NON-

INFRINGEMENT, MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  IN 

PARTICULAR, WITH RESPECT TO ANY PARTICULAR APPLICATION, USE OR PURPOSE, IN 

NO EVENT SHALL Endress+Hauser INC. BE LIABLE FOR ANY OTHER COMMERCIAL 

DAMAGE, INCLUDING BUT NOT LIMITED TO SPECIAL, INCIDENTAL, CONSEQUENTIAL OR 

OTHER DAMAGES.  Endress+Hauser DOES NOT WARRANT THAT THE FUNCTIONS 

CONTAINED IN THE PROGRAM WILL MEET YOUR REQUIREMENTS OR THAT THE 

OPERATION OF THE PROGRAM WILL BE UNINTERRUPTED OR ERROR FREE.

LIMITATION OF 

REMEDIES

Endress+Hauser' entire liability and your exclusive remedy shall be the replacement of any DVD-

ROM or diskette not meeting Endress+Hauser' "Limited Warranty" which is returned to 

Endress+Hauser with a copy of your receipt within the warranty period.  The remedy for breach of 

this warranty shall be limited to replacement and shall not encompass any other damages including 

but not limited to loss of profit, special, incidental, consequential, or other similar claims arising out 

of the use or inability to use such program even if Endress+Hauser has been advised of the possibility 

of such damages, or for any claim by any other third party.
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GENERAL This Agreement will be governed by the laws of the Commonwealth of Massachusetts.  Should you 

have any questions concerning this Agreement, you may contact Endress+Hauser in writing at:

Endress+Hauser Process Solutions AG

Kägenstr. 2, 

4153 Reinach

Switzerland

You acknowledge that you have read this agreement, understand it and agree to be bound by its 

terms and conditions.  You further agree that it is the complete and exclusive statement of the 

Agreement between you and Endress+Hauser which supersedes any proposal or prior Agreement, 

oral or written, and any other communications between you and Endress+Hauser relating to the 

subject matter of the Agreement.

Endress+Hauser RETURN 

POLICY

All sales are final (NO RETURNS) unless one of the following conditions is applicable:  Program is 

returned in its original packaging material within 7 days after shipment.  In such a case, a full refund 

is provided, less all incurred shipping and handling costs.  Program is returned within 30 days from 

the original shipment date.  In such a case a 20% restocking fee is applicable.  No returns are allowed 

on OPC Tool or ActiveX Tool.
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For your notes
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